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AV-8B MAP SYSTEM II: MOVING MAP COMPOSER 
SOFTWARE USERS MANUAL 

1.0 INTRODUCTION 

The Naval Research Laboratory is providing the Naval Air Systems Command (NAVAIR) 
AV-8B program with Moving Map Composer (MMC) software, installed on state-of-the-art Alpha 
workstations, to perform the following functions: 

• Design and build Aircraft Optical Disk (AOD) images from user-specified Compressed Aeronautical 
Chart (CAC) and scanned chart data; 

• Include emergency checklists, reconnaissance photographs, and other "data frames" in an AOD 
image; 

• Write completed AOD images to militarized Write-Once Read-Many (WORM) disks; 

• Evaluate failed AODs and recover from failed AOD image builds; 

• Design and build Mission Planning System Compact Disk Images (MPS-CDI) from user-specified 
CAC, scanned chart, and digital terrain elevation data (DTED); 

• Write MPS-CDIs to Recordable Compact Disk (CD-R) for mission planning purposes; 

• Scan and compress paper charts into a CAC-compatible format (when CAC or Arc Digitized 
Raster Graphics (ADRG) are not available) and include in an AOD image or MPS-CDI. 

These AV-8B Map System II (MAP-II) workstations will completely replace all map data 
functions and all optical disk image functions that are currently handled by the AV-8B Map, 
Operator, and Maintenance Stations (MOMS). 

2.0 SYSTEM CONFIGURATION 
2.1 Hardware 

Figure 1 illustrates the AV-8B MAP-II hardware components and the data flow between each 
of these components. Figure 2 shows the Small Computer Standard Interface (SCSI) and General 
Purpose Interface Board (GPIB) connections for the AV-8B MAP-II workstation and peripherals. 
Appendix A defines each of these components in detail and App. B describes how to set up the 
MAP-II hardware. 

2.2. Software 

Figure 3 is a simplified diagram of the principal MMC software operations: the MMC user 
inputs up to three primary data sources (CAC, DTED, and scanned charts) from which Mission 
Planning System (MPS) data and AOD data are processed and archived. 
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AV-8B MAP STATION II (Map-ll) 

MISSION PLANNING SYSTEM 
(MPS) 

AV-8B DIGITAL 
MOVING MAP SYSTEM 

Fig. 1 — AV-8B MAP-II hardware components 

Figures 4 and 5 illustrate how to build an AOD or MPS composition using two different 
methods (depending on available data). Figure 4 shows how to build a new, user-defined compo- 
sition from "scratch," while Fig. 5 shows how to build a new composition from a preexisting 
composition (when the user may or may not have all the source data available). 

The next two sections provide more detailed information on the MMC software. Section 3.0 
describes the MMC Graphical User Interface (GUI), including the world map workspace, tool bars, 
and all associated utilities. Section 4 provides step-by-step instructions on how to perform the most 
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Fig. 2 — AV-8B MAP-II SCSI and GPIB connections 
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Fig. 3 — Primary MMC software functions 

common MMC operations. This section was derived from a tutorial that NRL developed for the 
initial installation of the MAP-II workstation in China Lake, CA; Rota, Spain; and Aviano, Italy. 
A glossary of terms and definitions is provided in App. C. 

3.0 MMC GRAPHICAL USER INTERFACE 
3.1 Starting MMC 

To start MMC, log in to the MMC account and type MMC at the $ prompt. After several 
seconds, the main MMC Window will appear (Fig. 6). Sections 3.2 and 3.3 provide detailed 
descriptions and illustrations of the various functions and utilities that MMC provides. 
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Fig. 6 — Main MMC window 

3.2 Toolbars and Workspace Definitions 
3.2.1 World Map Workspace 

As shown in Fig. 6, the largest portion of the main MMC Window is a world base map on 
which to design AODI (AOD Image) and MPS-CDI compositions. We recommend that the user 
zoom in to an area of interest before designing a composition or adding overlays to optimize 
performance (e.g., speed up the graphics). MMC provides vertical and horizontal scroll bars at the 
right side and bottom of the base map to allow the user to scroll through the area of interest if 
the computer screen is not large enough to display it in its entirety. 

3.2.2 Title Information 

MMC provides six blocks of information in a title bar (Fig. 7) just above the base map: 

(1) A descriptive title for the AODI or MPS-CDI. 
(2) A unique file name (10 characters or less) for a final composition (this will also be used 

as a volume label when archiving to CD). 
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Fig. 7 — MMC title bar 

(3) A unique library ID number for the AODI or MPS-CDI. This ID number uses the format 
TTT-yyyy-vw-Mcccccc, where 

• TTT = the image type (AOD or MPS); 

• yyyy = the year the image was created; 

• wv = the version number of the image (001-999); 

• M = the map station ID: a base-36 number (0-9, A-Z) that identifies which map station 
created the original template(s) for this composition. Up to 36 individual map stations can 
be identified by this ID, of which 11 have been assigned (Table 1). 

• cccccc = a composition ID (000001-999999) unique for map station M. Two different 
map stations may create two different compositions with the same composition ID, but 
the map station ID (M, above) makes the image library number unique. This way, a user 
on one map station is not required to keep track of composition IDs on other map 
stations. 

(4) The chart series currently in use. To change the series, click on the Map Series/Scale 
selection box (Sec. 3.2.6) in the lower-right corner of the MMC Window. 

(5) The type of image currently being created (AOD or MPS). 
(6) A clock displaying the current date and time. To reset, log in to the SYSTEM account, then 

type SET TIME=dd-mmm-yyyy:hh:mm:s.s at the $ prompt. For example: SET TIME= 
20-JUL-1997:16:31:0.0 will set the clock to July 20, 1997, 4:31 pm. To verify the current date 
and time, type SHOW TIME. The system will print the current date and time. When finished, 
log out of the SYSTEM account and return to the MMC account. 

Table 1 — ID Numbers, System Names, and Locations of MAP-II 
Stations (as of 8/97) 

M System Name Location 

0 VOODOO NRL, Stennis, MS (old NRL computer; no DMU) 

1 MOE NAWC-AD, China Lake, CA 

2 LARRY MCAS Yuma, AZ 

3 CURLY NRL, Stennis, MS 

4 SHEMP MCAS Cherry Point, NC 

5 MAP005 Spain 

6 MAP006 Spain 

7 MAP007 Italy 

8 MAP008 Hughes, Indianapolis, IN 

Y JED NRL, Stennis, MS (F/A-18-owned) 

Z GRANNY NRL, Stennis, MS (F/A-18-owned) 
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Fig. 8 — Coverage definition buttons 

3.2.3 Coverage Definition Buttons 

The coverage definition buttons (Fig. 8) allow a user to define coverage areas in four ways: 
(1) using the mouse to pick points and define a polygon; (2) entering a series of lat/lon points to 
define a polygon; (3) using the mouse to draw a "rubber-band" box around a coverage; and (4) picking 
individual CAC segments. Note that when a button's icon is light gray, it is not currently available 

for use. 

3.2.3.1 Select/Unselect Coverage Area 

.-^ , ; The Arrow button is deactivated until the user has defined at least one area of 
^L        coverage (Sec. 3.2.3.2). When ready, click on this button, then click on individual area(s) 

.   > A     of coverage to be cut (or copied) and pasted between different chart series. Alternatively, 
^ >,.„ .,'   to select or unselect ALL areas of coverage at one time, click on one of the Edit menu 

options: Select All Coverages or Unselect All Coverages. As a coverage is selected, it 
turns yellow. 

3.2.3.2 Define an Area of Coverage 

Use any combination of these three buttons to define an area or areas of map coverage for 
inclusion in an AOD image or MPS CD image template. 

O', Use the Define Coverage Polygon button to define an irregularly shaped area. Click 
\ '■ on this button, then click on a set of points on the world map with the left (first) mouse 

button. The points will define the vertices of a polygon, which in turn defines the coverage 
.^ ....  ,    area. To close the polygon and fill the defined area with segments, double-click with the 

left mouse button. 

Use the Define Coverage by Latitude/Longitude button to define an area bounded by 
-«s^     I   specific latitude and longitude points. When a user clicks on this button, MMC pops up 
Lvi^r a Latitude/Longitude Entry Window (Fig. 9). Enter each geographic coordinate pair 
■*fr5'-?l   (latitude, longitude), indicate whether that coordinate crosses 180° longitude (relative to 

""*—   "'   the previous coordinate), then click on the Next Entry button. As each pair is entered, 
MMC will list it in the Latitude/Longitude Entry Window. The user can edit the entries before 
accepting the coverage area: 

• To delete a record, click on its entry in the list, then click on Delete. 

• To edit a record, click on its entry in the list, click on Edit, then edit the Latitude, Longitude, and 
Cross-180 entries in the top half of the window. 

• To start over, click on Clear All Coordinates. 
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Fig. 9 — Latitude/longitude entry window 

• When all coordinates are listed correctly, click on Accept Coordinates. The main MMC Window 
will return, and the defined template will appear on the world map. 

• To cancel from the Latitude/Longitude Entry Window and not save the points as a template, 
click on Cancel. The main MMC Window will return. 

Use the Define Coverage Rectangle button to define a rectangular area of coverage 
■—* ; using a rubber-band box. Click on this button, then click on the upper-left corner of the 

I area to be defined with the left (first) mouse button. Hold the mouse button down and 
'''-■*■"■"■>/ drag the resulting stretch-box to encompass the desired area. Note: the rubberbanding 
™—«/. onjy works from upper-left to lower-right! As long as the mouse button is held down, 
the stretch-box will be adjustable. As soon as the box is satisfactory, release the mouse button. 
Click once more with the left mouse button to accept the coverage area and fill the box with 
segments. 

3.2.3.3 Erase an Area of Coverage 

These buttons are deactivated until the user has defined at least one area of coverage with one 
or more of the previous three buttons (Sec. 3.2.3.2). Use any combination of the following three 
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buttons to erase areas of map coverage (i.e., remove coverage from an AOD image or MPS CD 
image template). 

Use the Erase Coverage Polygon button to erase an irregularly shaped area. Click on 
this button, then click a set of points on the world map with the left mouse button. The 
points will define a polygon enclosing the area to be erased. To close the polygon and 
erase the area, double-click with the left mouse button. 

Use the Erase Coverage by Latitude/Longitude button to erase an area bounded by 
specific latitude and longitude points. When the user clicks on this button, MMC pops up 
the Latitude/Longitude Entry Window (Fig. 9). (For more details, refer to Sec. 3.2.3.2.) 

Use the Erase Coverage Rectangle button to erase a rectangular area of coverage. 
Click on this button, then click on the upper-left corner of the area to be erased with the 
left (first) mouse button. Hold the mouse button down and drag the resulting stretch-box 
to encompass the desired area. Note: the stretch-box only works from upper-left to lower- 

''"""-''""'""; right! As long as the mouse button is held down, the stretch-box may be adjusted. As soon 
as the box is satisfactory, release the mouse button. Click once more with the left mouse button to 
erase the enclosed area. 

3.2.3.4 Pick/Unpick Individual Segments 

Use the Pick button to individually select segments to be added to or deleted from a 
template. In other words, this button acts as a toggle to select and deselect individual 
segments. 

3.2.4 Zoom Buttons 

The Zoom buttons (Fig. 10) allow a user to zoom into (or out from) an area of interest on the 
MMC base map. Zooming can be done via a stretch-box or by selecting a zoom factor and then 
zooming in or out by that factor. Note that when a button's icon is gray, it is not available for use 
(e.g., the Zoom-Out button will be unavailable until the user has zoomed in). 

3.2.4.1 Zoom In with a Stretch-Box 

Use the Stretch-Box Zoom button to zoom in to an area of interest with a stretch-box. 
31    Click on this button, then click on the upper-left corner of the area of interest with the left 

^i   (first) mouse button. Hold the mouse button down and drag the cursor to the lower-right 
corner of the area of interest.  Note: the stretch-box only works from upper-left to lower- 

right! As long as the mouse button is held down, 
the stretch-box may be adjusted. The box main- 
tains a constant aspect ratio identical to the 
display screen. This ensures that the contents 
of the final stretch-box fit perfectly on the 
display. As soon as the box is satisfactory, 
release the mouse button, then click again 
with the left mouse button to perform the zoom 
(Fig. 11). 

MtitUHIJjUjfljJttHJIjttJiitii 

Zoom 

Fig. 10 — Zoom buttons 
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Fig. 11 — Zooming in with a stretch-box, (a) before zoom and (b) after zoom 

3.2.4.2 Zoom Out by a Specified Zoom Factor 

; Use the Zoom-Out button to zoom out from the MMC base map. Click on this button, 
£*t\    adjust the zoom factor (Sec. 3.2.4.4), then click on the map to zoom out. Note: the user 

J,       cannot zoom out until he or she has zoomed in! This button will appear light gray when 
—~—-, it is unavailable. 

3.2.4.3 Zoom In by a Specified Zoom Factor 

...r;   i Use the Zoom-In button to zoom in to the MMC base map. Click on this button, adjust 
-^M£-    the zoom factor, then click on the map to zoom in. This button will turn light gray 

»        when the maximum zoom has been reached. 

3.2.4.4 Specify the Zoom Factor 

Zoom 
A J2x|        Click on the arrows to change the Zoom Factor (default = 2x). This value dictates how 

much to zoom out or in (e.g., with the Zoom Factor set to 8, clicking on the Zoom-In 
button will zoom into the world map by 8:1). The maximum Zoom Factor is 200. 

Two special settings are available below factor 2: PAN and ONE. To pan (i.e., scroll) around 
the world map, set the Zoom Factor to PAN, click on either the Zoom-In or Zoom-Out button, then 
click on the map with the left mouse button. MMC will redraw the map centered on the point 
selected. For example, clicking on the left edge of the map will scroll to the left. To return to the 
original, unzoomed world map, set the Zoom Factor to ONE, click on either the Zoom-In or 
Zoom-Out button, then click anywhere on the world map. 

3.2.5 Map Projection Selection Box 

Mercator  ~~> I Choose a map projection from this drop-down list: Mercator [default], North 
Polar, or South Polar. Use North Polar to work with data in the North Polar TS 

zone (North Polar segments will be displayed in dark green); use South Polar to work with data 
in the South Polar zone (South Polar segments will be displayed in yellow); and use Mercator for 
all other work. Note: if the user tries to select individual segments in a polar TS zone, but the MMC 
base map is displayed in Mercator, the mouse pointer may appear to be off by 1-2 segments. 
Switch to the correct Polar projection to fix this problem. 
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3.2.6 Map Series and Scale Selection Box 

j«Cfi2M> ~.! Choose a map series and associated scale from this drop-down list: JNC (1:2M) 
IÄ^ ' ' [default]; ONC (1:1M); TPC (1:500k); JOG (1:250k); TLM-100 (1:100k); TLM-50 
(1:50k); or DTED. Users can define coverages in one series, then switch to another series without 
losing what they've defined in the first. Users can also cut or copy coverages from one series and 
paste them into another (see Edit menu options Cut, Copy, and Paste in Sec. 3.3.2.2). 

3.2.7 Cursor Position Box 

This information box shows the current geographic position of the cursor on 
the MMC base map. Position is shown in decimal degrees of latitude and longitude 

or degrees, minutes, and seconds (depending on which is set in the Preferences menu, View 
Latitude/Longitude, Sec. 3.3.5.3). Use this box to help find areas of interest. 

3.3 Top Menu Bar 

3.3.1 File 

The File menu (Fig. 12) lets a user open a composition or image file, save a composition, and 
exit from MMC. 

3.3.1.1 New (Ctrl+N) 

Opens a new file in preparation for building an AODI or MPS-CDI composition. Open a new 
file only to build a unique AODI or MPS-ODI. See the Open options (below) for alternatives to 
New. If a user was designing a composition and did not save it before selecting New, MMC will 
issue a warning message and the chance to save the work prior to starting a new file. 

33.1.2 Open Working Composition (Ctrl+W) 

Opens a file containing a composition-in-progress for an AODI or MPS-CDI. Unlike a final 
composition, a working composition has no library number. In addition, MMC does not place any 
size restrictions on working files, so the user may build a large master composition as a working 
file, then break it into smaller compositions for final files. When the user selects Open Working 
Composition, MMC displays a list of working compositions from which to choose (Fig. 13). After 
choosing a composition, MMC returns to the base map and displays the selected composition 

(Fig. 14). At this point, the user can view the map data defined 
by the composition or modify the composition. 

Igtejaa  Overtax _ Coverage* jWwenc 
-C&HN; 

Cpsni-nags 

Bat 

Ctrt+w 

Cttl+F 

Cntri+I 

Cri+E 

55 
Fig. 12 — File menu 

3.3.1.3 Open Final Composition (Ctrl+F) 

Opens an existing file containing a final AODI or MPS-CDI 
that has been assigned a library number. When a user selects 
Open Final Composition, MMC provides a list of current final 
compositions (Fig. 15) from which to choose. After the user 
chooses one, MMC returns to the base map and displays the 
selected composition (Fig. 16). At this point, the user can view 
map data defined by the composition or modify the composition 
and save it under a new name. 
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Fig. 16 — Sample of final composition displayed on MMC base map 

3.3.1.4 Open Image (Ctrl+I) 

Opens an existing AOD or MPS image, builds a composition based on the image, and loads the 
composition into MMC for viewing and modification. After the user selects Open Image, MMC 
queries for the image type (AOD or MPS) and device (CD, AOD, hard disk). If the user selects to 
open the image from CD, MMC will provide a GUI for selecting and mounting the necessary CD 
in an available drive. See Sec. 4.1 for more information about mounting CDs in MMC. 

3.3.1.5 Save as Working Composition (Ctrl+S) 

Saves the current composition as a working file with no associated AOD/MPS-CDI library 
number. MMC does not place any size restrictions on working files, so the user may save a large 
master composition as a working file, then break it into smaller compositions for final files. MMC 
only keeps one version of each working file name; if the user tries to save a working file with 
a file name that already exists, MMC will ask if the user wants to overwrite the preexisting 
working file. 

3.3.1.6 Save as Final Composition 

Saves the current composition as a final file with a unique AOD or MPS-CDI library number. 
MMC restricts final compositions to the maximum size of the ODI type selected, AODI (260 Mb) 
or MPS-CDI (600 Mb). This size restriction is enforced prior to saving the final composition. If the 
user tries to save a file that is larger than these maximums, MMC will instruct the user to trim some 
data off the image first. By default, MMC builds the composition for an MPS-CDI; the user must 
specify that the composition will ALSO be saved as an AODI file. MMC prompts the user for the 
final file name and description. Final file names must be 10 characters or less and can only contain 
alpha-numerics (e.g., no "_," "-" etc.). Also, if the composition is too big to save to an AOD (i.e., 
over 260 Mb), MMC will issue a warning message. If the user chooses to fix the composition, 
MMC will display a message describing which scale(s) contain too much data, then give instructions 
on how to fix the composition before reattempting the save. 
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3.3.1.7 Close 

Closes the current composition and refreshes the main MMC Window. If the user has made 
unsaved changes, MMC will issue a warning and provide an opportunity to save the work prior to 
closing. 

3.3.1.8 Exit (Ctrl+E) 

Closes the current composition and exits from MMC. If the user has made unsaved changes, 
MMC will issue a warning and provide an opportunity to save the work prior to closing. 

3.3.2 Edit 

The Edit menu (Fig. 17) provides utilities to select coverages, cut (or copy), and paste coverages 
between scales, and undo or redo previous actions. 

3.3.2.1 Undo (Ctrl+Z)/Redo (Ctrl+R) 

Undo undoes the previous edit action (e.g., Cut). Redo repeats the previous action. 

3.3.2.2 Cut (Ctrl+X)/Copy (Ctrl+C)/Paste (Ctrl+V) 

To cut or copy one or more coverages from one scale to another, click on the Arrow button 
(Sec. 3.2.3.1), then click on each coverage area to be cut or copied (the selected coverages will turn 
yellow), then choose Cut or Copy. Alternatively, choose the Edit option Select All Coverages 
(described below), then choose Cut or Copy. Warning: only the most recent Cut or Copy action 
stays in memory. If the user Cut one coverage, and then Cut or Copy another before pasting the 
first, the first coverage will be lost forever! 

• Cut cuts the selected coverage from the current chart series and temporarily stores it in memory 
(to be pasted in another series, if desired). 

• Copy makes a copy of the selected coverage and stores it in memory. 

• Paste pastes the most recently cut or copied coverage from memory onto the current coverage. 

File , Edit f Overlays   Coverages   Preferena 

<»"!:-. -. 

Cut Ctrl+Xi 

Cooy 

P_aste-. 

Select All Coverages 

Unseied. Alt Coverages - Ctri+N 

"^^^- 

Fig. 17 — Edit menu 
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Fig. 18 — Overlays menu 

3.3.2.3 Select All Coverages (Ctrl+A)/ 
Unselect All Coverages (Ctrl+N) 

Select All Coverages selects all available 
coverages from the current chart series (all cov- 
erages will turn yellow) for cutting, copying, 
and/or pasting. Unselect All Coverages deselects 
selected coverages at the current chart series. 

3.3.3 Overlays 

The Overlays menu (Fig. 18) includes options 
to refresh the display and overlay shorelines, 
political boundaries, latitude and longitude grid, 
user-defined coverage polygons, and available 
data coverages. 

3.3.3.1 Refresh Display 

Redraws the current map information in the MMC Window. 

3.3.3.2 World Vector Shoreline (WVS) 

The base map for MMC and a standard product from the National Imagery and Mapping 
Agency (NIMA). This overlay draws the shorelines of the world and is ON by default (Fig. 19). 

3.33.3 Political Boundaries 

This overlay (ON by default) displays political boundaries between inland countries and states 
to provide a more robust base map (Fig. 19). Figure 20 shows the WVS overlay ON and the 
Political Boundaries overlay OFF. 

3.3.3.4 Lat/Lon Grid 

Displays a user-defined grid of latitude and longitude lines (OFF by default: Fig. 19). When 
the user turns this overlay ON, MMC will prompt for the grid spacing (default is 10° in latitude 
and longitude). Figure 21 shows the Lat/Lon Grid ON with a 20° grid. 

*t \           T   ^ 

Fig. 19 _ MMC base map with both WVS and 
political boundaries overlays on (default) 

Fig. 20 — MMC base map with WVS overlay on and 
political boundaries overlay off 
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Fig. 21 — MMC base map with lat/lon grid overlay on 

3.3.3.5 User-Defined Polygons 

Outlines each coverage the user defines. These polygons are useful in selecting specific coverages 
for Cut and Paste operations. This overlay is ON by default (Fig. 22a). When it is OFF (Fig. 22b), 
adjacent coverages are not as easy to distinguish. 

3.3.3.6 Available Coverage 

Displays all logged CAC coverage for the current map scale in light gray (Fig. 23a), all scanned 
chart coverage for the current scale in tan (Fig. 23b), and areas that contain both CAC and scanned chart 
data in purple (Fig. 23c). This overlay is OFF by default. Note: if the user is designing an MPS 

Fig. 22 — MMC base maps with user-defined 
polygons overlay (a) on and (b) off 

:        /          S>>~^ 

(c) \ss 

Fig. 23 — Available coverage (of data sources) overlays (a) CAC only, (b) CAC (gray) abutting scanned charts 
(tan); and (c) CAC (gray) surrounding area with both scanned charts and CAC (purple) 
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Coverages j Preferences   Tools   Windows 

' Include Working Composition       ,^mm^m———. 

" include Final Composition zzzzzzz—z 

[nclude Image 

Include Logged Source Coverage 

nclude Scanned Coverage 

image and selects DTED from the Map Series 
selection box (Sec. 3.2.6), Available Coverage 
will reflect all logged DTED coverage. 

3.3.4 Coverages 

The Coverages menu (Fig. 24) provides 
utilities to include one or more compositions, 
images, or scanned data sets in a new 
composition. 

3.3.4.1 Include Working Composition 

Fig. 24 — Coverages menu Retrieves a working composition for either 
an AODI or MPS-CDI. MMC will present a 
list of available compositions and prompt for 

which one to include. A modified working composition may be saved under the same name or a 
different name. If it is saved under the same name, the original will be deleted. 

3.3.4.2 Include Final Composition . 

Retrieves a final composition from the hard disk. MMC will present a list of available compositions 
and prompt for which one to include. Modifications to a final composition may only be saved under 
a new name. 

3.3.4.3 Include Image 

Dynamically creates a temporary composition from a source image that can then be used to 
define a new composition (or supplement an existing one). This option will retrieve the composition 
of either an AOD or MPS image from the hard disk, a CD, or an AOD. If the user selects to open 
the image from CD, MMC will provide a GUI for mounting the CD in an MMC drive (see Sec. 4.1). 
Finally, MMC prompts for the source image file name. 

3.3.4.4 Include Logged Source Coverage 

Builds a composition from a source coverage via a menu selection (Fig. 25). Valid source 
coverages are CAC and DTED CDs that have been logged into MMC. The menu selection box 
provides four columns of information for each entry: Info File name, CAC library number, date 
CAC was logged into MMC, and a geographic coverage description. CAC Info Files are named 
after the library number of their respective CAC CD. Note that some CAC CDs do not have an 
Info File (the first column lists 000000 instead of an Info File name and the last column lists 
"No Info File Located" instead of a descriptive title). CAC CDs without Info Files do not have any 
geographic description associated with them. 

3.3.4.5 Include Scanned Coverage 

Builds a composition from scanned chart coverage (i.e., map data that has been scanned within 
MMC and compressed into CAC segments, then logged and stored on hard disk or CD). The menu 
selection box provides four columns of information for each entry: Info file name, Scanned Coverage 
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Fig. 25 — Sample list of logged source coverages 
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Fig. 26 — Preferences menu 

file name, date scanned data was logged into MMC, 
and a brief description of the geographic coverage of 
the data. 

3.3.5 Preferences 

The Preferences menu (Fig. 26) allows the user to 
set certain preferences for the current MMC session, 
including whether to build an AOD or MPS composi- 
tion, the primary source from which to view CAC data 
in the current image (e.g., from CAC CD or from 
scanned data on the hard disk), and in what format to 
display latitude and longitude coordinates. 

3.3.5.1 Compose AOD/Compose MPS 

Sets the type of image to be built. This preference may be changed at any time during the 
creation of a map theater build. Note that restrictions on AOD images are more stringent than MPS 
images: 

• When switched to Composing AOD ON (default), MMC will design a composition based on the 
restrictions of AOD images (e.g., MMC calculates the final image size, #directories per scale and 
zone, #Mbytes per directory, etc.). Note that MMC does not limit a user from exceeding AOD 
restrictions (although it will issue warnings) until saving a final composition. 

• When switched to Composing MPS ON—by clicking on the Compose MPS option (Fig. 27)— 
MMC will compose an image based on the restrictions of MPS images (e.g., image size). DTED 
data is only available under the Compose MPS preference. 

3.3.5.2 View Chart Data Preferences 

Sets the source from which to view chart data (Fig. 28). Chart data may be viewed by selecting 
a coverage area with the arrow button, positioning the cursor in the area of interest, and pressing 
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Fig. 28 — View chart data preferences 

the third (right) mouse button (for more information on viewing chart data in MMC, see Sec. 4.3). 
Chart data will only be displayed for available CAC coverage in the source selected: 

• View CAC CDROM: sets the preference to view CAC data from a CAC CD (available from 
NIMA). When this preference is set and the user clicks (with the third mouse button) on a 
segment to be viewed, MMC will issue a message telling the user to load the necessary CD. For 
more information on loading and reading CDs, see Sec. 4.1. 

• View AOD: view CAC data from an AOD mounted in the Digital Map Unit (DMU). This option 
is not available until the user opens an AOD image by clicking on File, then Open Image. This 
option is also not available if there is no DMU attached to the system. 

• View MPS Hard Disk: view map data from an MPS image stored on the hard disk. 

• View MPS CDROM: view map data from an MPS image that has been logged and archived to CD. 
When this preference is set and the user clicks on a segment to be viewed, MMC will notify the 
user to load the necessary CD. For more information on loading, selecting, and reading CDs, see 
Sec. 4.1. 

• View Scanned Hard Disk: view scanned map data stored on the hard disk. 

• View Scanned CDROM: view scanned map data that has been logged and archived to CDROM. 
When this preference is set and the user clicks on a segment to be viewed, MMC will notify the 
user to load the necessary CD (see Sec. 4.1). 

3.3.5.3 View Latitude/Longitude Preferences 

Determines how MMC will display latitude and longitude coordinates: decimal degrees [default] 
or degrees, minutes, and seconds (Fig. 29). Latitude and longitude coordinates are used in the 
following areas of MMC: 

• the Cursor Position box in the lower-right corner of the main MMC display (Sec. 3.2.7); 

• to define or erase coverages by latitude and longitude; and 

• to pick control points after scanning a chart. 

3.3.6 Tools 

The Tools menu (Fig. 30) provides the user with an army of utilities, including logging in new 
media (including CAC and DTED CDs), checking subdirectory size limits while designing a 
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Fig. 29 — View latitude/longitude preferences 
Fig. 30 — Tools menu 

composition, generating a summary of the current composition, building an AODI to hard disk or 
AOD, working with checklists and other data frames, scanning paper charts into CAC for use in 
an AODI or MPS-CDI build, and archiving data (including scanned data, AODIs, MPS-CDIs, and 
checklists) to CD. 

3.3.6.1 AOD (or MPS) Options 

Depending on whether the user is composing an AOD image or MPS image (determined in the 
Preferences Menu, Sec. 3.3.5.1), the first item in the Tools menu will be either AOD Options or 
MPS Options. As shown in Fig. 31, there are four AOD options: Generate AOD Summary, Build 
AOD Image, Check Subdirectory Limit, and Copy AOD Image to WORM. There is only one MPS 
option, Build MPS Image. 

3.3.6.1.1 Generate AOD Summary—Generates a summary of any existing AOD composition, 
composition in development, or final AOD image (Fig. 32). For each zone, scale, and subdirectory 
in the composition or image file, AOD Summary provides the minimum and maximum latitude and 
longitude, the number of CAC segments defined, and the number of sectors that would be used if 
the image were written to an AOD. The summary also gives the total number of bytes in the 
composition. 

3.3.6.1.2 Build AOD Image [or Build MPS Image]—Builds a final image file from the user's 
AOD or MPS composition. Note: if the user has set the Compose AOD preference (Sec. 3.3.5.1), 
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Fig. 31 — (a) AOD and (b) MPS options menus (depends on image type set in preferences) 
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ii MAP COMPOSER SUMMARY. 
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Fig. 32 — Sample AOD summary listing 

MMC will automatically build an MPS image first, then the AOD image. If the user has set the 
Compose MPS preference, MMC will only build the MPS image. The Build AOD [or MPS] Image 
option is not available until the user has opened a final composition (Sec. 3.3.1.3). 

3.3.6.1.3 Check Subdirectory Limit—Can be used at any time while designing an AOD composition 
to determine whether the resulting image would fit on an AOD. When the user selects this function, 
MMC indicates whether the composition exceeds AOD subdirectory limitations and provides 
instructions on how to correct the problem, if necessary. 

3.3.6.1.4 Copy AOD Image to WORM—Copies an AOD image from the MMC hard disk to a 
WORM on the DMU. Follow the directions given by MMC for this function. Recommendation: 
label each WORM with the serial numbers of both the DMU and DMU Interface (DMUI) used to 
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write the WORM. If the WORM has been written to 3x, there should be three sets of DMU and 
DMU serial numbers on the label (some may be duplicates). 

3.3.6.2 CDROM Options 

Includes archiving data to CD and restoring logged sources from CD (Fig. 33): 

3.3.6.2.1 Archive Data to CDROM—"Premasters" a set of data into a CD image and writes the 
data to a CD. The CD images conform to the International Standard Organization (ISO) 9660 
standard for optical disk formats. When a user selects this option, MMC opens the Archive To 
CDROM Window (Fig. 34). Click on Premaster and select the data type to be archived: Scanned 
CAC Data, Aircraft Optical Data, Checklists/Data Frames Data, Mission Planning Data, CDROM, 
or Other Data. MMC will build an ISO 9660 image from that data. If the user has built an ISO 
image before, MMC will prompt the user to delete that file before building a new one. After 
premastering the data into an ISO image, select Cut to actually copy the data to a CD. When 
finished, select Close to return to the MMC Window. There are six data types that MMC can 
archive to CD: 

(1) Scanned CAC Data: If the user is archiving scanned data, MMC will pop up a list of valid 
chart series to be archived (JNC, ONC, TPC, JOG, TLM-100, or TLM-50). Only one series 
of scanned data may be archived to a single CD to maintain compatibility with the format 

Toois i Windows 

.40D Options 
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1 TPC(1:500K)=10Nh 

Data Frame Options „ Restore Logged Sources from CDROM Archive 
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Fig. 33 — CDROM options menu 

File 
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Close 
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CDROM 
Other Data.... 

Fig. 34 — Archive to CDROM window 
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and structure of CAC CDs. The only difference between CAC and scanned chart (SCAC) 
CDs is in the first field of their CD library numbers: tt-yyyy-e-MAPs-fnnnn, where: 

tt = type of data: CD for CAC or SC for SCAC; 

yyyy   = year (e-g-> 1997); 
e = edition (A-Z); 
'MAP' = the characters MAP; 
s = scale (0-6; described in App. C.3); 
f = a unique integer identifying the CD mastering facility (e.g., 0 = 3M); 
nnnn    = a unique ID number (0000-9999). 

MMC recognizes both CAC and SCAC CDs as valid sources, but the library numbers must be 
different so that newly logged SCAC CDs will not erroneously replace previously logged CAC 
CDS, or vice versa. The CD vs. SC at the start of the library number keeps the two data types 
distinct. 

(2) Aircraft Optical Data: When archiving AOD data, MMC first checks whether there is a 
valid AOD image on the hard disk. If not, MMC will not allow the user to premaster. If 
there is a valid AOD image, MMC will ask the user to verify the data to be archived. Select 
Yes to proceed (or Abort to cancel the operation). 

(3) Checklist/Data Frames Data: Archives data frames (e.g., checklists) to CD. MMC will 
issue a verification message: select Yes to proceed (or Abort to cancel). 

(4) Mission Planning Data: When archiving MPS data, MMC first checks that there is a valid 
MPS image on the hard disk. If not, MMC will not allow the user to premaster. If there 
is a valid MPS image, MMC will ask the user to verify the data to be archived. Select Yes 
to proceed (or Abort to cancel). 

(5) CDROM: Use this option to make a duplicate copy of any CD. MMC will display a 
verification message (answer Yes to proceed) then the CDROM Site Window. Load 
the CD to be copied into the CD changer, then click on the Start Processing button at the 
bottom of the CDROM Site Window (see Sec. 4.1 for more information about loading and 
selecting CDs in MMC). MMC will take the user through the necessary steps to premaster 
the data. 

(6) Other Data: Use this option to archive any other data on the MMC system. (It is particularly 
important to backup the bitmaps directory on a regular basis.) MMC will display a 
verification message (select Yes to proceed) then a File Selection Window to help the user 
find the directory and file(s) to be included (Fig. 35). After selecting the data files, MMC 
will guide the user through the necessary steps to premaster the ISO image. 

3.3.6.2.2 Restore Logged Sources from CDROM Archive—Restores previously logged sources 
from CD. When the user selects this option, MMC displays an informational message about restor- 
ing data from CD (click on the Restore button to proceed). MMC will then display the CDROM 
Site Window. After entering the CD to be read, click on the Start Processing button at the bottom 
of the window (see Sec. 4.1). 

3.3.6.3 Data Frame Options 

Includes a checklist editor, a window to view checklists and other data frames, and a utility to 
copy a checklist to a WORM (Fig. 36): 

3.3.6.3.1 Checklist Editor—After selecting this option, MMC will display the Checklist Editor 
Window (Fig. 37) to help the user build and modify AV-8B checklists that can be displayed in the 



AV-8B Map System II: MMC Software Users Manual 25 

\JMC_SYSUM-[OOf»OOO.GIT MAPS]'.für 

Directories 

)00] 

jiOOOJ 

Ji000]AODS,DIR;1 

jiO0ö]AÖD_AIMALYSIS.D1R;1    | 
|I000JAUD1T.DIR;1 

mmBiTMAPsmim^ 
000jCD_MASTCR.DSR:J 

.000ICOLPAI..DlR;l 

Fites 

mm 

Selection 

mmc_svstem:l000000( 

OK rilTar       Cancv!        H*ID 

Fig. 35 — File selection window: MMC files to be 
archived to CD 

Tools | Windows    -. 

ÄOD Options 

CDROM Options     - 
s 

,r^ta.Frarns.£?t^n-      Cheer Lsi Editor 
! Media Options 

Scan Options 

h 

Fig. 36— Data frame options menu 



Lohrenz et al. 

Fig. 37 — Checklist editor window 

cockpit moving map system. Editor functions include changing text color (Red, Green, or Amber) 
and font size (Small, Medium, or Large). A future version may support both Insert and Overstrike 
edit modes, but currently only Overstrike is available. 

To start a NEW checklist page: 

• Click on Select Checklist Set from the Options menu (Fig. 38) in the Checklist Editor Window. 

• Select Radar (the only valid set) from the list (Fig. 39). 

• Click on New from the File menu (Fig. 40) in the Checklist Editor Window. 

• The new checklist page will be blank, with the exception of the word MENU at the bottom; this 
is on the first page of every category in a checklist set. The cursor will be in the first character 
position of the first line to be typed on the page (Fig. 41). 

To OPEN an existing checklist file: 

• Click on Select Checklist Set from the Options menu (Fig. 38) in the Checklist Editor Window. 

• Select Radar (the only valid set) from the list (Fig. 39). 

• Click on Open from the File menu (Fig. 40) in the Checklist Editor Window. 

• Enter the desired category and page number in the Category/Page Selection Window (Fig. 42). 

• The selected checklist will be displayed in the Checklist Editor Window (Fig. 43). 
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Fig. 38 — Checklist editor: options menu 
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To set text color, click on the Red, Green, or Amber button, then click in the text area at the 
desired starting point and type. All new text will be in the selected color. 

To change text color, first click on the Red, Green, ox Amber button, then click on the character 
to be changed. For example, click on Amber, then click on a character to be changed (in Fig. 44, 
the user changed the selected character from red to amber). Type over any additional characters 
(immediately following the first) to change them to amber. Any other characters (not immediately 
following the first) must be changed by clicking again on Amber, then clicking on the new character. 
Future updates to MMC could support more user-friendly color changing. 

To change font size, first click on the Small, Medium, or Large button, then click anywhere 
in the line to be changed. For example, click on Large, then click on a line to be changed (in 
Fig. 45, the font size of the selected line is changed from small to large). Font size can only be 
changed an entire line at a time. Currently, MMC only supports Overstrike mode in the checklist 
editor. A future update could support Insert mode. 

The checklist editor provides various maintenance functions, including deleting and saving 
checklists. To delete a checklist set, click on Delete Checklist Set under the Options menu (Fig. 38) 
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!     HSf    QfSOTK 

■■.,,..,...,.,.;, ...,,.:, ,,iv... J 

H CoX>r              . jj 

H                                         H ..v««l            5 
Cr.:c-> 

1    islllü^S              1 

v 1«S*           ' 

Fig. 44 — Example of changing text color in MMC checklist editor: (a) click on new color (e.g., amber) then 
(b) click on letter to change (e.g., from red) 

Fig. 45 — Example of changing font size in MMC checklist editor: (a) click on new size (e.g., large) then 
(b) click in line to change (e.g., from small) 
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in the Checklist Editor Window. Note: Create Checklist Set (under Options) is not yet available. 
To save an edited checklist set (and keep the same name), click on Save under the File menu 
(Fig. 40) in the Checklist Editor Window. To save an edited checklist set with a new name, click 
on Save As under the File menu. MMC will prompt the user for the new name. To close an edit 
session without saving, click on Close under the File menu. 

3.3.6.3.2 View Data Frames—MMC provides a function to view any data frames (including 
checklists) in the current AODI. First, open an AODI—containing checklists or other data frames— 
by clicking on File in the MMC Window, then Open Image (Sec. 3.3.1.4). Then click on the Tools 
menu, Data Frames Options, View Data Frames to start a Data Frame Viewer Window listing all 
data frames in the current AODI (Fig. 46). To view a data frame, scroll through the list with the 
scroll bar (at the right of the list) and double-click (with the left mouse button) on the desired file 
name or use the arrows at the bottom of the window to scroll through the list, displaying each data 
frame in turn (Fig. 47). To exit from this window, click on File, then Exit. 

3.3.6.3.3 Copy Checklist to WORM—Select this option to copy a checklist to an AOD mounted 
on the DMU. Follow the directions given by MMC for this function. 
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Fig. 46 — Data frame viewer window Fig. 47 — Sample data frame 
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3.3.6.4 Media Options 

Includes logging and unlogging media (e.g., CAC or DTED data from NIMA) in the MMC 
source data bases (Fig. 48): 

3.3.6.4.1 Log Media—Logs new source data (CAC or DTED from NIMA) in the MMC source 
data bases. While logging in a new CAC or DTED CD, MMC will build a bitmap of the source data 
that will be used to calculate and overlay available coverages (Sec. 3.3.3.6) and incorporate logged 
source data (Sec. 3.3.4.4) into an AODI or MPS-CDI. When the user selects Log Media, MMC pops 
up the CDROM Site Window. After entering all the CDs to be logged, click on the Start Processing 
button at the bottom of the window (Sec. 4.1). 

Note: DO NOT eject any CDs until the "Logging Complete" message is displayed!! 

3.3.6.4.2 Unlog Media—Removes references to source data from the MMC log file. This is 
done if a previously logged source is found to be bad (e.g., an unreadable CD). Note: MMC will 
store multiple CAC CD versions, but not multiple DTED versions because NIMA provides unique 
edition numbers for CAC CDs, but not for DTED CDs. (A future version of MMC may provide a 
work-around to this problem.) Therefore, whenever NIMA issues a new version of a DTED CD, the 
user must unlog the previously logged version before logging the new one. 

3.3.6.5 Scan Options 

Scan Options include scanning paper charts into the CAC format (including all phases of 
compression) and deleting scanned data from MMC (Fig. 49): 

3.3.6.5.1 Scan Map Data—Scans paper charts and compresses the resulting data into the CAC 
format to augment existing CAC data. This utility facilitates the inclusion of new and updated 
charts (not yet available in digital form) to be included in an AODI or MPS image. The scanning 
process is comprised of 10 steps: 

• Select the chart series, projection, and control points format; 

• Scan the chart; 

• Clip the image (if desired); 

• Identify the chart datum and ellipsoid; 
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Fig. 48 — Media options Fig. 49 — Scan options 
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• Enter control points; 

• View and accept the control points; 

• Process the scanned data; 

• Scan another chart (if desired); 

• Quit scanning and finalize data; 

• Review scanned data. 

These steps are detailed in the following sections. 

Step 1: Select the chart series, projection, and control point format. 

After clicking on Scan Options, choose the chart series to be scanned (Fig. 50). MMC will 
display a window listing some scanning tips. To proceed, click on the button that says "Begin with 
[chart series]" MMC will display the Scan Map Data Window. 

From the Scan Map Data Window, click on Preferences, then Projection (Fig. 51). Select 
Polar if the chart is based on a polar or conic projection (i.e., either the latitude or longitude lines 
are curved); select Nonpolar if the chart is based on a rectilinear projection (i.e., both latitude and 
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Fig. 50 — Select chart series to scan 

Fig. 51 — Projection preferences for scanning chart data 
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longitude lines are straight). Click on Preferences again, then Enter Latitude Longitude as: (Fig. 52). 
Select a control point format: Decimal Degrees; Degrees, Minutes, and Seconds; or MGRS (Military 
Grid Reference System). 

Step 2: Scan the chart. 

Position the chart on the scanner. Click on Scan, then Start Scan (Fig. 53). MMC will bring 
up the Scan Overview Window and display the scan as it progresses (Fig. 54). A full scan (i.e., 
11" x 16" section of chart) takes about 3 min. 

At any time during the scan, the user can click on Cancel at the bottom of the Scan Overview 
Window (e.g., if the chart is upside-down or sideways, or if the wrong chart is in the scanner). 
MMC will discard any scanned data from the current scan and let the user start over. 

Fig. 52 — Latitude/longitude preferences for selecting control points 
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Fig. 53 — Start scan 

Fig. 54 — Scan overview window as scan is progressing 
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Step 3: Clip the scanned image (if desired). 

When the scan is complete, the Scan Overview Window will show the entire scan, zoomed out 
to fit the window (Fig. 55). Now the user can do one of three things: 

(a) Accept the Image Without Clipping: click on Accept Image (No Clip Points) at the bottom 
of the Scan Overview Window; 

(b) Cancel and Return to MMC: click on Cancel in the Scan Overview Window; or 
(c) Select Clip Points to Trim the Image: position the cursor over the scanned image in the 

Scan Overview Window and define a clipping polygon by clicking with the left (first) 
mouse button. MMC will draw a red line to show the clip region as the user selects each 
point. On the last clip point, double-click the mouse button to complete the clipping polygon; 
MMC will redraw the clipped image (Fig. 56). To start over, select the Clear Clip Points 
button at the bottom of the window. When the clip points are acceptable, select the Accept 
Clip Points button. To NOT clip the image, select Cancel at any time. 

Step 4: Enter datumlellipsoid. 

After the user accepts the image (clipped or not), MMC will display a list of datum and 
ellipsoid combinations (Fig. 57). Select the correct combination for the scanned paper chart (datum 
and ellipsoid information is usually printed in one of the chart's margins), then click OK. MMC 
will display a verification message; click on Use Datum to proceed. Table 2 lists all the supported 
datums and ellipsoids in MMC. 

Fig. 55 — Scan overview window after scan has completed 
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Fig. 56 — Scan overview window showing clipped image 
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Table 2 — List of Datum and Ellipsoid Combinations Supported 
by MMC 

ID Datum Name Ellipsoid 

1 Adindan Clarke 1880 
2 Arc 1950 Clarke 1880 
3 Australian Geodetic 1984 Australian National 
4 Bukit Rimpah Bessel 

5 Camp Area Astro International 

6 Djakarta (Batavia) Bessel 
7 European 1950 International 

8 Geodetic Datum 1949 International 

9 Ghana WGS 84 

10 Guam 1963 Clarke 1866 

11 Gunung Segara Bessel 

12 G. Serindung WGS 84 

13 Herat North International 

14 Hjorsey 1955 International 

15 Hu-Tzu-Shan International 

16 Indian Everest 
17 Ireland 1965 Modified Airy 
18 Kertau 1948 (Malayan revised triangulation) Modified Everest 
19 Liberia 1964 Clarke 1880 
20 User-entered (not supported in MMC) 
21 Luzon Clarke 1866 
22 Merchich Clarke 1880 
23 Montjong Lowe WGS 84 
24 Nigeria (Minna) Clarke 1880 
25 North American 1927 (CONUS) Clarke 1866 

26 North American 1927 (Alaska and Canada) Clarke 1866 

27 Old Hawaiian, Maui International 

28 Old Hawaiian, Oahu International 

29 Old Hawaiian, Kauai International 

30 Ordnance survey of Great Britain (1936) Airy 
31 Qornoq International 

32 Sierra Leone 1960 WGS 84 
33 South American (Provisional 1956) International 
34 South American (Corrego Alegre) International 
35 South American (Campo Inchauspe) International 
36 South American (Chua Astro) International 
37 South American (Yacare) International 

38 Tananarive Observatory 1925 International 
39 Timbalai Bessel 
40 Tokyo Bessel 
41 Voirol WGS 84 

42 Special datum, Indian Special Everest 

43 Special datum, Luzon Special Clarke 1866 

44 Special datum, Tokyo Special Bessel 
45 Special datum, WGS 84 Special WGS 84 

46 WGS 72 WGS 72 
47 WGS 84 WGS 84 
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Step 5: Enter control points. 

Enter a set of control points to accurately georeference the image (i.e., reference each pixel to 
a latitude/longitude coordinate). If control points are not entered correctly, the resulting image 
could look warped, inverted, or otherwise corrupted (Fig. 58). 

MMC will display the message Please Select First Control Point. Click on OK. MMC will 
remove the Scan Overview Window and display the scanned image at its full scale (i.e., not 
zoomed out) in the Scan Map Data Window (Fig. 59). Use the scroll bars at the right and bottom 
of this window to scroll through the image and find appropriate control points (e.g., intersections of 
latitude and longitude lines). 

Fig. 58 — Example of scanned chart that was improperly georeferenced 
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Fig. 59 — Scan map data window: full-scale scanned chart (ready for control points) 

To pick a control point: 

(a) Click with the left (first) mouse button on a point in the scanned image. 
(b) MMC will display a Control Point Entry Window with a zoomed-in view of this point and 

the surrounding area to let the user pick the point more accurately (Fig. 60). In this window, 
click on the selected point as accurately as possible (e.g., the intersection of latitude and 
longitude lines), then enter the latitude and longitude values for this point. To reenter these 
values, click on Clear and reenter them. Note: if MGRS is the preferred control point 
format (in step 1), enter the control points in MGRS units, as shown in Fig. 60, not latitude 
and longitude. 

(c) Click on Accept when the control point is acceptable. To reselect it, click on Cancel and 
pick the point again. 
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Fig. 60 — Control point entry window, including zoomed-in area surrounding the point, plus entry boxes for 
geographic coordinates (here, in MGRS format) 

Repeat this process for each selected control point. Pick a minimum of three for nonpolar charts 
(six for polar) and a maximum of 25 control points. Ideally, for nonpolar charts, the user should 
pick at least the four corner points of the scanned 
image (or points close to the four corners) to get an 
accurate georeference. For polar charts, also select 
several control points within the chart. 

Step 6: View and accept control points. 

After selecting all necessary control points, click 
on Scan then View/Accept Control Points in the 
Scan Map Data Window (Fig. 61). MMC will 
display a window listing all the selected control 
points and allow the user to edit or delete them, if 
necessary (Fig. 62). When the user is satisfied with 
the list of control points, click on Accept Control 
Points. 
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Fig. 61 — View/accept control points Fig. 62 — List of selected control points 
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Step 7: Process scanned data. 

MMC now will transform the control points from the scanned chart's source datum and ellipsoid 
to WGS-84. After a few seconds, MMC will display the main MMC Window, zoomed in to the 
scanned area, with a composition of the scanned image overlaid by a latitude and longitude refer- 
ence grid. MMC will also display a message asking if the scanned coverage area is in the right area 
(Fig. 63); i.e., is it in the right location and of the right size and shape? The user may have to move 
this message to the side if it obscures the template. 

Note: if the image was clipped, MMC will have clipped it to the nearest tessellated spheroid 
(TS) segment boundary to keep the entire segment intact. Therefore, the template boundaries may 
not exactly match the user-entered clip bounds (the template may be slightly larger). 

If the template does not look right, click No to the message. MMC will let the user edit the list 
of control points again or start the scan over. 
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Fig. 63 — Composition of newly scanned chart data and verification that it is correct 
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If the template looks good, click Yes. MMC will return to the Scan Map Data Window, 
process the data, and display a meter of the percent completed (Fig. 64). Note: the data will be 
subsampled into TS segments, but not yet color-compressed. 

Step 8: Scan another chart (if desired). 

When the processing has completed, the message at the top of the Scan Map Data 
Window will tell the user to scan another chart or quit. To scan another chart of the same scale 
(or an adjacent section of the same chart), reposition the chart on the scanner and repeat the steps 
to scan, starting with Start Scan (step 2). To scan another chart of a different scale, quit this scan 
session first (i.e., continue with steps 9 and 10), then start a new scanning session (with step 1) for 
the new scale. 

Step 9: Quit scanning and finalize data. 

If there are no more charts to scan in this scale, select Quit. Quit can be used at any time to 
stop scanning and return to the main MMC Window. 

If the user has just finished scanning a chart and selects Quit, MMC will display a message 
saying there is scanned data to be finalized. At this point, either click on Finalize Scanned Data 
to compress it now, or Do This Later to postpone compression for another time. 

When the user selects Finalize Scanned Data, MMC will color-compress all the scanned data 
into SCAC files and display a meter showing the percent completed (Fig. 64). Wait until processing 
has finished before trying to do anything else in MMC! 

Note: if MMC dies (e.g., due to a power failure) while compressing scanned data, simply restart 
MMC and click on Tools, Scan Options, Scan Map Data. Choose the chart series of the scanned 

data that was being compressed. MMC will bring up 
the Scanning Tips Window (click on Begin with 
[chart series]), then the Scan Map Data Window. 
Click on Scan, then Quit, and then continue with 
Finalize Scanned Data as previously described. 

When processing has completed, MMC will 
display a message saying that scanned data has been 
added or removed at the current scale. Click Acknowl- 
edge. MMC will return to the main MMC Window. 

Step 10: Review scanned data. 

After returning to the main MMC Window, the 
user can review the data just scanned by first defin- 
ing an area of coverage that includes that scanned 
data. Next, click on Preferences, then the View CAC 
Data option list, then View Scanned Hard Disk 
(Sec. 3.3.5.2). Finally, click with the right (third) 
mouse button on the area to be reviewed. Figure 65 
depicts three adjacent scanned charts being reviewed 

Fig. 64 — Meter showing the percent complete (see Sec. 4.3 for more information on reviewing chart 
while processing scanned chart data data in MMC). 
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Fig. 65 — Reviewing scanned chart data: three adjacent scanned charts 

3.3.6.5.2 Delete Scanned Data—This should only be done if the scanned data has been archived 
to CD (Sec. 3.3.6.2.1) or if the data is no longer required. 

There are three ways to delete scanned data: (1) delete all the scanned data from the hard disk 
for a specified scale; (2) delete a defined area of scanned data from the hard disk (at one or more 
scales); or (3) delete scanned data from the hard disk while reviewing the scanned image (which 
is done prior to archival). 

(1) To delete all scanned data (at a given scale) from the hard disk, click on Tools, Scan 
Options, Delete Scanned Data, For Scale, then the scale to delete (Fig. 66). MMC will 
request verification; click on Continue to proceed or Abort to cancel. If this scanned data 
has not been archived to CD, MMC will display a warning; click on Delete Anyway to 
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Fig. 66 — Delete all scanned data (for a given scale) from the MMC hard disk 

proceed or Abort to cancel. MMC will display a meter to show the percent of scanned data 
deleted until it has finished. 

(2) To delete a defined coverage of scanned data (at one or more scales), first use the MMC 
define coverage buttons (Sec. 3.2.3) to outline the area(s) to be deleted (individual segments 

- or entire areas). Then click on Tools, Scan Options, Delete Scanned Data, and For the 
Defined Coverage (Fig. 67). MMC will display a verification message; click on Continue 
to proceed or Abort to cancel. 

(3) The third method of deleting scanned data is while the user is reviewing it. This method 
is not part of Tools, Scan Options, Delete Scanned Data, but it is an easy way to selectively 
delete scanned data on the hard disk prior to archiving it to CD or including it in a 
composition. In particular, this is probably the best way to delete "partial segments" around 
the edge of a scanned area in preparation for seamlessly merging the scanned data with 
surrounding CAC data. Partial segments are not completely filled with chart data (i.e., they 
are partially black), so if they are inadvertently used as part of a final composition, partial 
segments would introduce gaps into the image. 

To delete or edit the scanned data this way, the user must be reviewing it. Display the composition(s) 
of the scanned data to be edited by clicking on Coverages, Include Scanned Coverage, then select 
the coverage(s) to be included (Sec. 3.3.4.5). Note: only scanned data stored on the hard disk can 
be edited, not archived data on CD. Zoom in to the area of interest, then review the data by clicking 
on the area with the right (third) mouse button. MMC will display the scanned data in a View Data 
Window. Next, pan around the data (using the left (first) mouse button), and find the area to be 
deleted. For more information on viewing data in MMC, see Sec. 4.3. 

Next, delete a single TS segment by clicking on a point inside the segment with the middle 
(second) mouse button. MMC will issue a message: "Are you sure you want to permanently DELETE 
the segment you click on?" Click on Cancel (default) to return to the View Data Window without 
deleting, or click on DELETE to delete the segment just selected. Note: MMC does not currently 
display segment boundaries (a future release could do this). To delete partial segments around the 
edge of the scanned image, click very close to the edge of the image (with the middle mouse 
button), then select DELETE. MMC will redisplay the image with the deleted segment removed, so 
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Fig. 67 — Delete a defined coverage of scanned data (at one or more scales) 

from then on, the user can visualize how large a segment is and where adjacent segments are 
located. 

3.3.7 Windows 

The Windows menu (Fig. 68) executes various MMC utilities in pop-up windows, including 
Composition Data Size, Scanned Data Size, Data Sources, CDROM Readers, and History. 

3.3.7.1 Composition Data Size Display 

Monitors how much disk space is used for each scale of chart data in a composition (Fig. 69). 
If one or more scales has too much data (calculated by the number of AOD sectors permitted per 
scale), the graph will turn red for that scale (Fig. 70a). If the size of the composition (for all the 
scales combined) is greater than 260 Mb—i.e., too large to fit on an AOD—then the "Total" graphs 
will turn red. This can happen even if each individual scale of data is within the size limits of an 
AOD (Fig. 70b). 

3.3.7.2 Scanned Data Size Display 

Monitors how much scanned data (per scale) is stored 
on the hard disk (Fig. 71). If a scale exceeds 600 Mb, the 
graph will turn red for that scale, indicating that it's time 
to archive that scale of scanned data to CDROM. 

Windows | 

' Composition: Data Size Displays 

Scanned Data Size Display: 

Data Sources Display 

AOD/MPS Area Status 

*\ History Display 
-gar 

Fig. 68 — Windows menu 

3.3.7.3 Data Sources Display 

Lists all logged data sources for the current composition, 
including DTED (for MPS compositions only), CAC and 
scanned chart data (Fig. 72). As the user defines new cov- 
erages, this display will reflect any new logged sources that 
are applicable. 
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Fig. 69 — Composition size within limits 
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Fig. 70 — Composition data size exceeds AOD limit, (a) JOG scale exceeds 260 Mb and (b) individual JOG, TPC, 
and JNC scales are within 260 Mb, but total exceeds 260 Mb 
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AOD Area: 
(NO AOD image on the Hard Drive) 

MPS Area: 
PAKISTAN       MPS-1935-G01-0000043       (Build Complete)  I 

„ : 

Ackivr.viodfjP 
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Fig. 73 — AOD/MPS area status 

3.3.7.4 AOD/MPS Area Status 

Lists all AODIs and MPS images currently stored on the MMC hard disk (Fig. 73). The list 
includes the descriptive title, library number, and build status for each image. Click on Acknowledge 
to erase this display and return to the main MMC Window. 

3.3.7.5 The History Display 

Presents a log file of errors, warnings, and other messages issued by MMC. This display will 
be used for troubleshooting and bug fixes until it is no longer needed, at which point it will be 
disabled. 

4.0 COMMON MMC OPERATIONS 
4.1 Loading and Selecting CDs in MMC 

MMC uses the CD changer for a variety of operations, including archiving scanned data, 
viewing chart data, etc. The procedure for loading and selecting a CD is the same regardless of the 
application: 

(1) Load the required CD(s) into one of the six slots of the CD changer or in the internal CD 
drive. For certain functions (e.g., viewing CAC data from CD), MMC will specify which 
CD to load. 

(2) MMC will pop up the CDROM Site Window (Fig. 74) listing all seven CD slots, including 
six in the CD changer (CDROM1 through CDROM6) and the Alpha's internal CD drive 
(CDROM7). 

(3) Click (with left mouse button) on the CD device number(s) to be selected (1 through 7). 
As the user selects a device number, MMC will enter it in the list (Fig. 75). 

(4) Select Scan Readers (in the lower-left corner of the window); MMC will list the titles of 
the CDs on the selected readers (Fig. 76). 

(5) If any of the listed CDs is not required, click (with middle mouse button) and drag that 
CD's number from the list to the Trash Can at the bottom of the window. Any CDs 
that were listed below the deleted CD will be bumped up to fill in the list (Fig. 77). 
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Fig. 74 — CDROM site window 
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Fig. 77 — CDROM site window: deleted one CD 
reader from the list (#3) 

Fig. 78 — CDROM site window: switched priority of 
CD readers #2 and 4 

(6) The user can rearrange the order of the CDs in the list, if necessary. For example, when 
listing source CDs to be used in building an AODI, the order will dictate priority: the CD 
listed first gets top priority. This allows the user to properly overlap CAC sources with 
different edition numbers, since more recent data should get higher priority than older data. 
To reorder the CD list, click (with middle mouse button) and drag the desired CD number 
to its new location (Fig. 78). 

(7) When all required CDs are listed in the appropriate priority order, select Start Processing 
(at the bottom of the window). 

(8) Alternatively, select Clear Readers to start the process over or Cancel to cancel the operation 
and return to MMC. 

4.2 Logging CAC, Scanned CAC, and DTED CDs 

Prior to building any AOD or MPS compositions, the user must first log all the necessary 
NIMA data sources. As a standard practice, NRL recommends that the user log in every available 
data source as it is received from NIMA. Figure 79 is a data flow diagram that illustrates how to 
log data sources at various stages of MMC processing. 

To log source data, perform the following steps: 

• Insert the required CD(s) into empty slots of the CD changer caddy, then load the caddy in the 
CD changer. Note: load each CD face-down in a caddy tray. 

• Click on Tools, then Media Options, then Log Media. 

• MMC will pop up the CDROM Site Window (Fig. 74). Currently, MMC will only allow a user 
to log in one CD at a time, so select the first CD reader containing a CD to be logged, click on 
Scan Readers, then Start Processing. MMC may prompt for a descriptive title for each CD (e.g., 
"Continental US at TPC scale"). Logging one CD takes about 1 min. 

• After the first CD is logged, repeat the process for the second CD. 

• For more information about loading and selecting CDs in MMC, refer to Sec. 4.1. 
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LOG MEDIA 

LOAD SOURCE! 
COROMsON : 
CD READERS 

SELECT CD 
READERS 

SAVE AS WORKING OR 
FINAL COMPOSITION 

PROCESS SOURCE 
CDROM($) 

QUIT _YES_J ALL SOURCES: 
LOGGED? 

Fig. 79 — Logging data sources: complete before building any compositions 

4.3 Viewing Chart Data 

4.3.1 Viewing Chart Data from a Programmed AOD 

This section lists the steps for viewing chart data from a previously programmed AOD. 

(1) Mount an AOD containing chart data in the DMU: 
• Turn off the DMU (use the power switch on front). 
• Load an AOD containing chart data into the DMU. 
• Turn the DMU back on. 
• Wait 30 s after loading the AOD in the DMU before continuing. 

(2) Load the AOD image into MMC: In MMC: click on File, then Open Image. Follow the 
directions to open an AOD image from the DMU and display the composition in the MMC 
Window (Fig. 16). 
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(3) Zoom into an area of interest with the Stretch-Box Zoom Button (Sec. 3.2.4.1). 

(4) Set the View [data source] option in Preferences to View AOD (Sec. 3.3.5.2). 

(5) View the chart data in the image: 
• Click on an area of interest with the right (third) mouse button. MMC will pop up a 

View Data Window displaying chart data centered on the selected point. 

• To scroll around the image, position the cursor at the edge of the View Data Window 
and click with the left mouse button. For example, to scroll up, position the cursor at 
the top edge of the window and click. (When switching TS zones, there will be a pause 
while the new color palette loads.) 

• From the Map Coverage Window (displaying the chart data), click on File, then Close 
to return to MMC. 

• In MMC, click on Windows, then Composition Data Size Display to show which other 
chart scales (and how much data) are included in this image (Sec. 3.3.7.1). 

• Switch to one of the other scales of data (e.g., JOG or JNC) by clicking on the Map 
Series/Scale box in the lower-right corner of the MMC display (Sec. 3.2.6). 

• View the new scale of CAC data in the image; scroll around this new image. 

4.3.2 Viewing Chart Data from a CAC CD 

This section lists the steps for viewing chart data from a source CAC CD. 

(1) Log the desired CAC CD into MMC, if not already done (Sec. 4.2). 
(2) Set View [data source] option in Preferences to View CAC CDROM (Sec. 3.3.5.2). 
(3) Define an area to be viewed using the coverage definition buttons (Sec. 3.2.3). 
(4) Click inside the coverage area with the right (third) mouse button. 
(5) MMC will prompt the user to load the appropriate CAC CD (Fig. 80); load it into the CD 

changer caddy (Sec. 4.1). 
(6) After selecting the CAC CD in the CDROM Site Window (Fig. 74), click on Scan Readers, 

then Start Processing. MMC will display the CAC data, centered on the selected point 
(step 4, above). 

Please load the following CDROM: 
CD-2995-C-2MP3~00001 

Cancel Help 

Fig. 80—MMC prompt to load CAC CD 
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(7) To scroll around the image, position the cursor at the edge of the View Data Window and 
click with the left mouse button. For example, to scroll up, position the cursor at the top 
edge of the View Data Window and click. (When switching TS zones, there will be a 
pause while the new color palette loads.) 

(8) From the Map Coverage Window (which displays the CAC data), click on File, then 
Close to return to MMC. 

4.4 Design, Build, and Archive a New AODI and MPS-CDI 

This section itemizes how to design, build, and archive a new AODI and MPS-CDI. To use this 
as a tutorial, use the sample data sources provided to design the sample composition described. All 
tutorial samples are given in { }. 

(1) Display all available coverages: 

• Click on File then New. 

• Zoom into an area of interest {Hawaii and SW California} (Sec. 3.2.4.1). 

• Click on Overlays then Available Coverage. 

• MMC will display the coverage of all data that has been logged, to date, at the selected 
scale. 

(2) Log in any data sources {two CAC CDs of TPC (1:500k) series: CD-1995-C-MAP3- 
10001 and CD-1996-B-MAP3-2003} needed to build the images (see Sec. 4.2). 

(3) Design a composition {Hawaii and China Lake, CA in the TPC series}: 

• Use the coverage definition buttons (Sec. 3.2.3) to define two areas of coverage {"Big 
Island" of Hawaii and China Lake, CA, areas}. 

• MMC will display each coverage area as a template comprised of colored boxes; the 
color reflects the TS zone of the data and the boxes represent TS segments. See 
App. C2 for more information about TS. 

• Use the Composition Data Size Display (Sec. 3.3.7.1) to monitor how much space has 
been used and keep the composition within the limits of an AOD. 

(4) Save the composition: 

• Click on File then SaveAs Final Composition. 

• Enter a file name and description when prompted. 

(5) Reopen the same composition. (As a security measure, MMC requires that the user open 
a final composition and not modify it prior to building the AODI): 
• Click on File then Open Final Composition. 

• Scroll through the list and select the AOD composition (not the MPS composition) just 
created. MMC will display the templates on the world map. 

(6) Build the AODI and MPS images (MMC automatically builds both): 

• Click on Tools then AOD Options, then Build AOD Image. 

• MMC will pop up a Data Sources Window (Fig. 72) listing which data sources are 
needed {CD-1995-C-MAP3-10001 and CD-1996-B-MAP3-2003}. 

• MMC will also pop up the CDROM Site Window (Fig. 74). 
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• Load the necessary CAC CDs in the CD changer. From the CDROM Site Window, 
select all drives with the required CDs. Click on Scan Readers then Start Processing 
(Sec. 4.1). MMC will now build the AOD and MPS images. 

• Wait until MMC says the image build is complete {2 min} before continuing with the 
next step. 

(7) Open the AOD image and review it: 
• Click on File then Open Image. Follow the directions to open the new AOD image file 

from the hard disk. 
• Set View [data source] option in Preferences to View AOD (Sec. 3.3.5.2). 

• View the CAC data in the AODI by clicking on an area of interest with the right (third) 
mouse button (Sec. 4.3). 

(8) Archive the AODI to CD: 
• Click on Tools, CDROM Options, Archive Data to CDROM (Sec. 3.3.6.2.1). 

• The Archive to CDROM Window will open. From this window, click on File, then 
PreMaster..., then AOD. 

• Wait until MMC finishes premastering before continuing {2 min}. 

• Insert a blank CD face-up in the CD caddy, then load the caddy in the CD writer. Wait 
until the CD writer's green disc light is ON (not blinking) before continuing. 

• Click on File (still in the Archive to CDROM Window) then Cut. 

• Wait until the CD writer has finished writing to the CD before continuing! Important: 
even after MMC says the write is finished, wait until the CD writer's Read (green) and 
Write (red) lights stop blinking! (There is no other way for the CD writer to "tell" 
MMC that the write is finished.) The green Disc and 4x lights will stay on. 

• Select Close from the Archive to CDROM Window to return to the MMC Window. 
• Again, be sure the CD writer's Read and Write lights have stopped blinking, then eject 

the CD from the CD writer. 
• Label the CD with an indelible pen. Include the date, AOD image library ID, a descriptive 

title, and a volume label. 

(9) Review the archived AODI from CD: 
• Load the AODI CD in the CD changer caddy (Sec. 4.1). 

• In the main MMC Window, click on File, then Open Image (Ctrl-I). Follow the directions 
to open the AOD image file from CD. 

• View the CAC data in the AOD image by clicking on an area of interest with the right 
(third) mouse button (Sec. 4.3). 

(10) Open the MPS image and review it: 
• Click on File, then Open Image (Ctrl-I). Follow the directions to open the MPS image 

file from the hard disk. 
• Set View [data] option in Preferences to View MPS Hard Disk (Sec. 3.3.5.2). 

• View the CAC data in the MPS image by clicking on an area of interest with the right 
(third) mouse button (Sec. 4.3). 

(11) Archive the MPS image to CD: repeat step 8, substituting MPS for AOD in the Premaster... 
selection. 

(12) Review the archived MPS image from CD: repeat step 9, substituting MPS for AOD in 
Open Image selection. 
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4.5 Add Data to an Existing Composition 

This section describes how to add a new scale of CAC data to an existing composition. To use 
this as a tutorial, use the sample instructions given in { } to add new data to the composition 
designed in Sec. 4.4. 

(1) Choose a new scale and geographic area for the data to be added {JOG}. 
(2) Display all available coverages (Sec. 4.4, step 1). 
(3) Log any new data sources required {CD-1996-B-MAP2-20007: Western US at JOG Scale}, 

see Sec. 4.1. 

(4) Open the final composition to be modified: 
• In MMC, click on File, then Open Final Composition (Ctrl-F). 

• Scroll through the list of available compositions and select the desired AOD composition 
{the composition built in Sec. 4.4, step 4}. MMC will display the templates for that 
composition on the world map. 

(5) Define additional template(s) for the new scale: 
• Tip: copy existing template(s) from one scale {TPC} scale to a new scale {JOG}: 

- Click on Edit, Select All. The templates will turn yellow. 
- Click on Edit, then Copy (Ctrl-C). 
- Change scales by clicking on the Chart Series and Scale button (in the lower-right 

corner of the MMC Window) and selecting the new scale {JOG} from the pop-up 
list. MMC will clear the world map of all current templates in preparation for 
defining templates in this new scale. 

- Click on Edit, then Paste (Ctrl-V). MMC will paste the previously selected templates 
into the new scale. Note that the size of the segment boxes will be different than they 
were in the previous scale, since segment size is scale-dependent. Also note that only 
the templates that are available in the new scale (i.e., data that has been logged, to 
date) will be pasted. 

• If desired, modify these templates in the new scale, by clicking on one of the buttons 
to define or erase coverage (Sec. 3.2.3). 

• As in Sec. 4.4, use the Composition Data Size Display (Sec. 3.3.7.1) under Windows 
to monitor how much space has been used, and keep the composition within the limits 
of an AOD. 

(6) Review the data at the new {JOG} scale by clicking on the templates with the third 
mouse button. The CDROM Site Window will come up; click on the CD reader containing 
the new CAC CD {CD-1996-B-MAP2-20007}, then click on Scan Readers, then Start 
Processing. 

(7) Save this work: Click on File then Save Final Coverage. {Give this composition a dif- 
ferent name from the one used in Sec. 4.4, step 4}. 

(8) Reopen the new composition, build an AODI and MPS-CDL review these images, and 
archive either or both to CD, as described in Sec. 4.4 (steps 5-12). 

4.6 Building an AOD (i.e., Copying an AODI to an AOD) 

This section summarizes the procedure for copying an AOD image to an AOD. To use this 
section as a tutorial, use the sample instructions in { }. 
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(1) Load the desired composition: 
• In MMC, click on File, then Open Final Composition. 

• Select the composition to be copied {AOD-1995-001-0000041, titled AV8B North Pacific 
Rim}. 

(2) Build an AOD image: 
• Click on Tools, then AOD Options, then Build AOD Image. 

• A verification message will appear, click Yes. 

• A second message will appear to verify clearing the working area (since only one 
MPS/AOD image can be built at a time), click Yes. 

(3) Load all required data sources {CD-1995-C-MAP3-10001, CD-1996-B-MAP3-2003, and 
CD-1996-B-MAP2-20007} in the CD reader (see Sec. 4.1 for more information on loading 
and selecting CDs in MMC). 

(4) Mount an AOD in the DMU (see Sec. 4.3.1, step 1). 

(5) Copy the AOD image to an AOD: 
• Reopen the AOD image: in MMC, click on File, then Open Image. Follow the directions 

to open an Aircraft Optical Image from hard disk. 

• Click on Tools, then AOD Options, then Copy AOD Image to WORM. 

• A verification message will appear, click Yes. 

• As the image is copied to the AOD, a meter will show its progression until completion. 

• After the copy is complete, view the image from the AOD (Sec. 4.3.1). 

4.7 Checklists 

4.7.1 Viewing Existing Checklists from an AOD 

Related Sec. 3.3.6.3 {Data Frame Options under the Tools menu). 

(1) Mount an AOD containing checklists in the DMU: 
• Turn off the DMU (use the power switch on front). 

• Load an AOD containing chart data in the DMU. 

• Turn the DMU back on. 

• Wait 30 s after loading the AOD in the DMU before continuing. 

(2) In MMC, click on File then Open Image. Follow the directions to open an AOD image 
from the DMU. 

(3) View checklist data: click on Tools, Data Frame Options then View Data Frames. It will 
take MMC several seconds to display the Data Frame Viewer Window (Fig. 46). When 
it does, scroll through the available checklists for this AOD (Fig. 47). 

4.7.2 Editing Checklists on the Hard Drive 

MMC only permits editing of checklists on the MAP-II hard drive, not on an AOD. In MMC, 
click on Tools, then Data Frame Options, then Checklist Editor. MMC will display the Checklist 
Editor Window (Fig. 37), which allows the user to edit the text, text color, and font size of 
selected checklist pages. Refer to Sec. 3.3.6.3 {Data Frame Options under the Tools menu) for 
detailed instructions of how to edit checklists. 
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4.7.3 Copy a Checklist to an AOD/WORM 

(1) Mount an AOD containing checklists in the DMU (see Sec. 4.3.1, step 1). 
(2) In MMC, click on File then Open Image to open an AOD image (checklists on AODs 

must be accompanied by an AOD image). 
(3) Select AOD as the type of image to open then select DMU as the device to read from. 
(4) After the AOD image is loaded, click on the Tools menu, then Data Frame Options, then 

Copy Checklist to WORM. Follow the directions given by MMC to copy a checklist set 
from the MMC hard disk to the AOD. 

4.8 Scan a Chart and Archive the Data to CD 

(1) Scan a chart: follow the instructions given in Sec. 3.3.6.5 to scan a chart into MMC, clip 
the image, georeference the scanned chart data using user-specified control points, trans- 
form the data to the WGS-84 datum, scan adjacent charts (if desired), compress the data 
into the CAC format, and review the final scanned CAC ("SCAC") image. 

(2) Archive the SCAC data to CD: follow the instructions given in Sec. 3.3.6.2 to archive 
scanned data to CD. 

(3) Log in the SCAC CDROM: follow the instructions given in Sec. 4.2 to log an SCAC CD 
into MMC. 

(4) Review the archived SCAC data from CDROM: 
• Click on Preferences, then be sure the View [data source] item in that menu is View 

Scanned CDROM. If not, click on the View [data source] item and choose View Scanned 
CDROM from the drop-down list (see Sec. 3.3.5.2). 

• Follow the instructions in Sec. 4.3.2 (viewing chart data from a CAC CD), steps 3-8, 
substituting SCAC for CAC in each step. 

(5) Delete scanned data from the MMC hard disk: once the user is satisfied that the data on 
the new SCAC CD is satisfactory, he or she can delete the scanned data from the hard 
disk. Refer to Sec. 3.3.6.5 (Delete Scanned Data) for detailed instructions on each of the 
three ways to delete scanned data: by scale, by defined coverage area, or while reviewing 
the scanned data. 

4.9 Build an MPS CD with DTED, CAC, and Scanned CAC (SCAC) Data 

This section summarizes the procedure for building an MPS CD using DTED and Scanned 
CAC (SCAC) data. To use this section as a tutorial, use the samples given in { }. 

(1)   Display the existing DTED coverage overlay: 
• Click on File then New. 

• Click on Preferences, then Composing AOD ON, then Compose MPS. 

• Switch the data series to DTED using the Chart Series/Scale button in the lower-left 
corner of the main MMC Window. 

• Zoom into the area of interest {Hawaii and SW California} using the Stretch-Box Zoom 
button. 

• Click on Overlays then Available Coverage. 

• MMC will display the coverage of all existing, logged DTED CDs. 
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(2) If necessary, log in any additional DTED CD(s) required {TCD DTED140} as described 
in Sec. 4.2. 

(3) Design compositions {Hawaii and China Lake} using SCAC, CAC, and DTED data: 
• Define area(s) of coverage using the buttons in the lower-left corner of the main MMC 

Window (Sec. 3.2.3.2). 
• MMC will display the defined DTED area(s) in colored boxes, where the color reflects 

the TS zone of the data and each box represents a TS segment (see App. C, Sec. 2.5 
for more information on TS zones and segments). 

• Switch the data series to a chart scale {JOG} using the Chart Series/Scale button in the 
lower-left corner of the main MMC Window. 

• Click on Overlays, then Available Coverage. Available chart data {all JOG data that is 
logged in, to date} will be displayed: CAC data in gray, scanned data in tan, and a 
combination of CAC and scanned data in purple. 

• To be sure the composition is not getting too large, click on Windows, then Composition 
Data Size Display to see a dynamic meter showing how much space has been used and 
whether the image has exceeded the limit for this scale of data. {Note: to keep a tutorial 
short, try to keep each data coverage around 5-10 Mb in the meter; if either DTED or 
JOG is larger than 10 Mb, trim the coverage using one of the Erase Coverage buttons 
at the bottom of the MMC Window}. 

(4) Save this work: click on File then SaveAs Final Composition. 
(5) Reopen this composition. (As a security measure, MMC requires that users open a final 

composition and not modify it prior to building the MPS-CDI): 
• Click on File then Open Final Composition. 
• Scroll through the list of available compositions and select the MPS composition just 

created. MMC will display the composition on the world map. 

(6) Build the MPS image: 
• Click on Tools, then MPS Options, then Build MPS Image. 
• MMC will pop up a Data Sources Window listing which data sources (e.g., CAC CDs) 

are needed. 
• MMC will also pop up the CDROM Site Window. 
• Insert all the necessary CAC, SCAC, and DTED CDs (listed in the Data Sources 

Window) in the CD changer caddy, then load the caddy into the CD changer. Click on 
Scan Readers, check that the correct CDs are loaded, then click on Start Processing. 
MMC will now build the MPS image. (For more information on loading and selecting 
CDs in MMC, see Sec. 4.1.) 

(7) Wait until MMC completes the MPS image build before continuing to the next step. 

(8) Open the MPS image and review it: 
• Click on File then Open Image (Ctrl-T). Follow the directions to open the MPS image 

file from the hard disk. 
• Click on Preferences then on the View [data sources] drop-down list. Select View MPS 

Hard Disk. 
• View the CAC data in the MPS image by clicking on an area of interest with the right 

(third) mouse button. (See Sec. 4.2 for more information on viewing data.) 

(9) Archive the MPS image to CD: 
• Click on Tools, then CDROM Options, then Archive Data to CDROM. 
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• The Archive to CDROM Window will open. From this window, click on File, then 
PreMaster, then Mission Planning Data. See Sec. 3.3.6.2 for more information on 
archiving MPS data to CD. 

(10)   Review the archived MPS image from CD: 
• Insert the MPS CD in an empty slot in the CD changer caddy, then load the caddy in 

the CD changer. 
• In the main MMC Window, click on File then Open Image (Ctrl-I). Follow the directions 

to open the MPS image file from CD. 

• View the CAC data in the MPS image by clicking on an area of interest with the right 
(third) mouse button. (See Sec. 4.2 for more information on viewing chart data.) 

4.10 Build an MPS Image from an AQDI on a WORM 

This section specifies how to build an MPS image from an AODI on a WORM. 

(1) Mount an AOD containing chart data in the DMU (Sec. 4.3.1, step 1). 
(2) Open the AOD image and extract the composition: 

• In MMC: click on File then New. 

• Click on Coverages then Include Image. Follow the directions to open an AOD image 
from the DMU. 

• Save the composition from the AOD to the MMC hard disk: click on File then SaveAs 
Final Composition. Enter file name and description of the final composition. 

• Note: If all the sources have been logged in for this composition, MMC will let the user 
save it. If not, those that are not available will be removed from the composition and 
displayed; click on File and SaveAs Final Composition again. 

• Reopen this composition. (As a security measure, MMC requires that users open a final 
composition and not modify it prior to building the MPS): click on File then Open 
Final Composition. Scroll through the list of available compositions and select the MPS 
composition (not the AOD composition) just created. MMC will display the composition 
on the world map. 

(3) Build the MPS image: 
• Click on Tools, then MPS Options, then Build MPS Image. 

• MMC will pop up a Data Sources Window (Fig. 72) listing which data sources (e.g., 
CAC CDs) are needed. 

• MMC will also pop up the CDROM Site Window (Fig. 74): 

- Insert all necessary CAC, SCAC, and DTED CDs (listed in the Data Sources Window) 
in the CD changer caddy, then load the caddy into the CD changer. 

- From the CDROM Site Window, select all the CD drives that contain the necessary 
CDs for this operation. See Sec. 4.1 for more information about selecting and 
mounting CDs for use in MMC. 

- Click on Scan Readers, check that the correct CDs are loaded, then click on Start 
Processing. 

• MMC will now start building the MPS image. MMC will ask if the user wants to delete 
the previous MPS image from disk. Answer YES - there can only be one image resident 
on the hard disk at a time. MMC will delete the old image from hard disk, then build 
the new image. 

• Wait until MMC completes the MPS image build before continuing to the next step. 
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(4) Open the MPS image and review it: refer to Sec. 4.4, step 11. 
(5) Archive the MPS image to CD: refer to Sec. 4.4, step 11. 
(6) Review the archived MPS image from CD: refer to Sec. 4.4, step 12. 
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Appendix A 

AV-8B MAP-H COMPONENTS 

A1.0 ALPHASTATION 

The Central Processing Unit (CPU) for the AV-8B MAP-II is an Alphastation 255/233 
(manufactured by Digital Equipment Corporation) with the following configuration: 

• 64 Mbytes of parity memory 
• 4.3 Gbytes of disk space 
• 1 high-resolution 17" color monitor 
• 1 VMS-style keyboard 
• 1.44 Mbyte floppy diskette drive (SCSI) 
• PCI to SCSI host bus adapter 

At the time of the initial MAP-II purchase (FY96), each of these Alphastations cost about 
$14,500 (GSA price) and came with a 1-yr warranty. 

A2.0 AOD 

An Aircraft Optical Disk (AOD) is a militarized Write-Once, Read-Many (WORM) Optical 
Disk that NRLSSC procures from Honeywell (part number 8509831) under contract #N00014-93- 
C-6016. A Japanese company developed specialized glass with a proprietary coating to be used for 
these AODs. However, this company stopped production of the glass components in 1993. Honeywell 
purchased a large quantity of glass to continue producing AODs for NAVAIR as a "last-time buy" 
agreement. 

An AOD ($1,230 each) is two-sided and contains up to 260 Mb of data per side. Current 
aircraft moving map systems can only access one side of the AOD at a time; the aircraft must land 
before the pilot can flip the AOD to access the other side. The data is stored in the form of an AOD 
image (AODI). 

Data cannot be deleted or overwritten on an AOD, but old data can be "skipped" (i.e., ignored) 
and/or new data can be added to an AOD in the form of a new AODI. Up to 16 AODIs can be 
written to, and accessed from, an AOD if the total space used by these images does not exceed 
260 Mb. 
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A3.0 AODI 

An Aircraft Optical Disk Image (AODI) is an exact replica of the information to be written to 
an AOD. Depending on a user's choice, MMC will write an AODI to a file on the Alpha disk, 
archive it to recordable Compact Disk (CD-R), or copy it to an AOD via the DMU. 

A4.0 CD CHANGER 

The Compact Disk (CD) changer installed on the MAP-II holds up to 6 CDs at one time, 
although the workstation can only access one at a time; i.e., the CD changer is treated as a single 
device. (For more information about using the CD changer on the MAP-II workstation, see Sec. 4.1: 
"Loading and Selecting CDs in MMC") The CD changer supports quad-speed reads from CDROM 
and CD-R. The systems were purchased from Acersoft Corporation for approximately $2,000 each 
in FY96. 

A5.0 CD RECORDER 

The CD recorder installed on the MAP-II is a Yamaha CD Studio with quad-speed Kodak 
PCD225 CD writer (part no. 120135) purchased from BTG, Inc. The price in FY96 was $10,475, 
although that price has since dropped (reference: NAWC, Indianapolis). MMC uses an NRL-developed 
CD-R Graphical User Interface (GUI) to archive various information to CD; e.g., MPS-CDIs, 
AODIs, and scanned chart data. 

A6.0 DIGITAL VIDEO MAP SET 

The AV-8B Digital Video Map Set is comprised of a Digital Map Computer, Color Display, 
and Digital Memory Unit (DMU). Together, these components provide an in-flight, near-real-time, 
digital moving map capability to the AV-8B. 

The moving map system is supported by the ground-based AV-8B Mission Support Systems 
(MSS), the Maintenance Data System-II (MDS-II), Mission Planning System-II (MPS-II), and the 
MAP-II workstation. The MDS-II extracts aircraft maintenance information that is written in-flight 
to a reserved portion of the DSU memory. The MPS-II System allows a mission planner to design 
mission overlays (e.g., threats, routes, targets, etc.) to be loaded in the aircraft's Mission Computer 
via the DSU. The MAP-II workstation allows an operator to define, tailor, and build map theaters 
for a given area of operations. These map theaters are also loaded in the aircraft's Digital Map 
Computer via an AOD. 

The Digital Map Computer and Display Computer combine the map data (built on the 
MAP-II) with the mission data (built on the MPS-II) and display the resulting image on a 4.5" x 4.5" 
color monitor in the aircraft. Once the mission is completed, the MPS-II operator can erase the 
DSU and reprogram it with new mission data without altering the base map on the AOD. 

A7.0 DMU AND DMUI 

The Digital Memory Unit (DMU) was used in the original MOMS system and is now used in 
the MAP-II workstation. The DMU (Honeywell part #8509830-002) is used exclusively for writing 
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militarized AODs. The DMU communicates with the Alphastation via a DMU Interface (DMUI, 
HTI part number DMUI-01), which translates between the Honeywell DMU's fiber optic protocol 
and the computer's SCSI-1 protocol. NRLSSC developed the Open VMS-based driver on the 
Alphastation to communicate with the DMU via the DMUI. 

A8.0 MOMS 

The Map, Operator, and Maintenance Stations (MOMS) were developed by HTI to support 
map, mission planning, and maintenance operations. The MOMS were used to define map coverages 
at various scales and copy selected chart data to an AOD, define necessary mission overlays and 
copy those to a DSU, etc. All of the AV-8B MOMS functions have been replaced by the AV-8B 
Muxbus Data System (AMDS-II): the MAP-II workstation and Moving Map Composer (MMC) 
software replaces the MOMS' Map Station, the MPS-II replaces the MOMS' Operator System, and 
the MDS-II replaces the MOMS' Maintenance System. 

A9.0MPS 

The Mission Planning System II (MPS-II) was developed by NAWC Weapons Division, China 
Lake, CA, to replace the mission planning portion of the Horizons Technology, Inc. (HTI) MOMS. 
The MPS-II is based on a portable notebook computer with a 120 MHz Pentium processor. 

A10.0 MPS-CD 

The Mission Planning System Compact Disk (MPS-CD) stores up to 650 Mb of map data in 
the form of an MPS-CDI. The MPS CD is the sole link between the MAP-II and MPS-II systems. 

A11.0 MPS-CDI 

The Mission Planning System Compact Disk Image (MPS-CDI) contains CAC data, sometimes 
supplemented with DTED, of an area of interest for mission planning purposes. An MPS operator 
uses the MPS CDI map coverage to design and position mission overlays, such as threats, routes, 
targets, waypoints, etc., which are then stored on a DSU and installed in the aircraft, along with 
the AOD (which stores the chart coverage). 

A12.0 SCANNER 

The MAP-II workstation uses the original flatbed Howtek "Scanmaster" scanner that was procured 
for the MOMS in FY90. This scanner can scan at 300, 200, 150, 100, and 75 dpi (dots per inch). 
The MAP-II will implement only the 300 dpi (highest resolution) scan. To integrate this scanner 
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in the MAP-II, a General Purpose Interface Board (GPIB) board was procured from National 
Instruments ($495 each) and a software driver was procured from EQUIcon Software ($575 each). 

MMC scans paper charts and processes them into the CAC format, to be included in AODIs 
and MPS-CDIs as required to supplement existing CAC data. Scanned data should be used if there 
is no CAC data available for the area of interest or if there are more recent paper charts that have 
not yet been distributed as CAC by the National Imagery and Mapping Agency (NIMA). 



Appendix B 

SETTING UP THE MAP-II WORKSTATION 

The following procedure details how to set up the MAP-II workstation and connect all the 
peripherals: 

(1) Unpack all equipment from the boxes. 
(2) Arrange equipment in workspace: 

• Set DMUI on table; 
• Place CD writer on top of DMUI; 
• Place Alpha CPU on top of CD writer; 
• Place CD changer on top of the CPU; 
• Place monitor, keyboard, and mouse next to stack of equipment; 
• Place scanner on a table with enough clearance for the moving scan bed. 

(3) Plug peripherals into the back of the CPU: 
• Monitor: Plug the monitor's video cable into the video port on the CPU (in the 

upper-right corner of the back of the CPU box (pictures of a monitor and sunglasses 
label this port). 

• Keyboard/Mouse: Plug the keyboard and mouse into their respective ports on the CPU 
(in the lower-center, pictures of a keyboard and a mouse label these ports). 

• Scanner: Plug the scanner cable into the GPIB port on the CPU box (in the right-center, 
the port is labeled GPIB). 

• CD changer: Plug a Centronix/High Density SCSI cable into the internal SCSI port on 
the CPU box (SCSI A, located next to the keyboard and mouse connections). Plug the 
other end of the cable into the CD changer's SCSI port (use the port on the right, above 
the power plug on the CD changer). Plug a SCSI terminator into the other CD changer 
SCSI port. 

• CD writer: Plug another Centronix/High Density SCSI cable into the external SCSI 
port on the CPU box (SCSI B, located between the monitor and the scanner connections). 
Plug the other end of this cable into the CD writer SCSI port labeled "host" (the 
right-most SCSI port when viewing the CD writer from the back). 

• DMUI: Plug the Centronix/Centronix cable into the other SCSI port on the CD writer. 
Plug the other end of this cable into either of the DMUI SCSI ports. Plug a SCSI 
terminator into the remaining DMUI SCSI port. 

(4) Power: 
• Plug power cords into each peripheral (scanner, DMUI, CD writer, CD changer, CPU, 

and monitor) then plug into unplugged power strip. 

• Check that all equipment is turned OFF at their individual power switches BEFORE 
plugging in power strip. 
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• Plug in and turn on power strip. 

• Turn on the peripherals in the following order: 
(1) DMUI (power switch on the back, then on the front of the box). 
(2) CD writer, CD changer, scanner, and monitor. 
(3) Map station CPU. 

(5) Check device configuration and boot Map Station: 
• Wait until the map station's >» prompt is displayed. 

• Check that the CD writer's red HDD light is off. If it is on, press the RESET button 
on the front of the CD writer (which will turn off the light), then at the >» prompt on 
the Map Station monitor, type INIT. 

• When the >» prompt returns on the Map Station monitor, wait 5-10 s, then type 
SHOW DEVICE. The Map Station should display a listing similar to that shown in 
Table Bl. 

• If this listing is incomplete or inaccurate, turn off the CPU, then turn off the power 
strip, turn the power strip back on and turn the CPU back on. Repeat the CD writer 
checks (and RESET if necessary), >»INIT and >»SHOW DEVICE commands. If 
the device listing is still inaccurate, repeat this power cycle 1-2 more times, then call 
Bob Murray at Hughes, Indianapolis, IN. 

• When the device listing is correct, type B (for boot) at the >» prompt. It will take 
about 3 min to completely boot up the system. 

(6) Log in: 
User name: MMC 
Password: 8675309 

Table Bl—AV-8B MAP-II Device Listing at Boot Prompt 

DEVICE ID DEVICE NAME DESCRIPTION (not listed) 

DKAO RZ26F System Disk 

DKA100 RZ29B MMC Disk 

DKA200 Pioneer CDROM DRM-624X CD Changer Device MMC1 

DKA201 Pioneer CDROM DRM-624X CD Changer Device MMC2 

DKA202 Pioneer CDROM DRM-624X CD Changer Device MMC3 

DKA203 Pioneer CDROM DRM-624X CD Changer Device MMC4 

DKA204 Pioneer CDROM DRM-624X CD Changer Device MMC5 

DKA205 Pioneer CDROM DRM-624X CD Changer Device MMC6 

DKA400 RRD45 Internal CD Device MMC7 

DKB401 Toshiba CDROM Drive:XM CD Writer Drive 

DVAO Internal Floppy Disk Drive 

MKB400 CD Studio Device 

EWAO Ethernet (e.g., 00-00-F8-22-64-OD) 

PKAO SCSI Bus ID 7 Internal SCSI Bus-A 

PKBO SCSI Bus ID 7 External SCSI Bus-B 



Appendix C 

GLOSSARY OF ACRONYMS AND TERMS 

C1.0 PROCESSING TERMS 
Cl.l Composition (or Template) 

A composition is a user-defined geographic coverage area (or set of areas) saved as a series of 
bitmaps (Fig. Cl). A composition includes a bitmap for each contiguous geographic area, within 
each TS zone, and at each chart scale required to build the user's AOD image or MPS image. Each 
"bit" in the composition's bitmap(s) represents a single TS segment of CAC data (and/or DTED, 
if the user is designing an MPS image). 

C1.2 Image 

An image is the actual data set (including CAC data, scanned chart data, DTED, or some 
combination of these) to be copied to an AOD or MPS-CD. MMC constructs an image from a 
composition's bitmaps. Figure C2 illustrates a sample image comprised of CAC data. 

Fig. Cl — Sample MMC composition Fig. C2 — Sample image (chart data) 
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C2.0 DATA TYPES 

C2.1 ADRG 

ARC (equal-Arc-second Raster Chart) Digitized Raster Graphics (ADRG) is a standard, digital, 
raster chart product produced and distributed on CDROM by NIMA. To produce ADRG, paper 
charts are scanned and transformed into the ARC system frame of reference. Data collected from 
a single chart/map series and scale are maintained as a worldwide, seamless, data base in which 
each pixel is represented by a 24-bit RGB (red, green, and blue) color value and exists at a distinct 
geographic location. All ADRG data have been adjusted to the World Geodetic System 1984 
(WGS 84) horizontal datum. ADRG is the source data for both CAC and CADRG. For more details, 
refer to NIMA's Digitizing the Future report or web site (NIMA 1997). 

C2.2 Compressed Aeronautical Chart (CAC) 

The CAC data base is a compressed (48:1) form of ADRG. CAC was originally produced by 
NRL and is now produced and distributed on CDROM by NIMA. CAC is the base map for current 
AV-8B and F/A-18 moving map displays (future systems, e.g., TAMMAC will use CADRG 
instead). CAC is organized into Tessellated Spheroid (TS) segments, as described in the TS definition 

(below). 

To produce CAC, NIMA converts ADRG digital map images from the ARC system frame of 
reference into the TS projection using a neighborhood averaging function, which effectively 
reduces the resolution of the data from 256 pixels per inch (ppi) to 128 ppi for compatibility with 
current aircraft moving map displays. The averaged data values are then color-compressed from 
24 bits per pixel (full color data) to 8 bits per pixel according to a predefined color palette. 
The data are also spatially compressed, a process that replaces every nonoverlapping group of 
2x2 pixels in the data set with a 1-byte codeword and creates a unique codebook for 
every 2" x 2" segment of data. The final data compression ratio for CAC is 48:1 over ADRG. Since 
most ADRG CDROMs are not filled to capacity, while most CAC CDROMs are, there may be over 
65 ADRG CDROMs compressed onto a single CAC CDROM. See Lohrenz and Ryan (1990) for 

more details. 

C2.3 Compressed ADRG (CADRG) 

Produced and distributed on CDROM by NIMA CADRG was designed to be a jointly coordinated 
compression of ADRG to be used in any application requiring rapid display of a map image or 
manipulation of the image of a map in raster form. CADRG achieves a nominal compression of 
55:1 over ADRG, excluding supplemental data such as color palettes and codebooks. CADRG is 
processed similarly to CAC except that CADRG has a data density of 169 pixels per inch (CAC 
is 128 ppi) and CADRG maintains the ARC coordinate system of ADRG (CAC uses the Tessellated 
Spheroid projection system). CADRG will replace CAC as the standard raster chart data to be used 
in the TAMMAC cockpit moving map systems. For more details, refer to NIMA's Digitizing the 
Future report or web site (NIMA 1997). 
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C2.4 Digital Terrain Elevation Data (DTED) 

DTED is a uniform matrix of terrain elevation values that provides basic quantitative data for 
systems that require terrain elevation, slope, and/or gross surface roughness information. DTED is 
produced and distributed on CDROM by NIMA. DTED is available at two different resolutions: 

• Level 1: Content is comparable to the contour information represented on a 1:250,000 scale chart. 
Latitudinal post spacing is 3 arc seconds (about 100 m); longitudinal post spacing varies by 
latitude (see Table Cl). 

• Level 2: Content is comparable to the contour information represented on a 1:50,000 scale chart. 
Latitudinal post spacing is 1 arc second (about 30 m); longitudinal post spacing varies by latitude 
(see Table Cl). 

For more information about DTED, refer to NIMA's Digitizing the Future publication or web 
site (NIMA 1997). 

C2.5 Tessellated Spheroid (TS) 

TS is the projection system used to store CAC data. TS was developed by Honeywell, Inc. as 
a structure for seamlessly storing and displaying global chart data on a cockpit moving map display. 
TS stores CAC data in rectilinear segments, where one segment is characterized as follows: 

• 2" x 2" section of scanned paper chart; 

• 256 x 256 pixels of raster data; 

• a single file on the CAC distribution CD; 

• smallest piece of data in MMC (drawn as a square bisected by a diagonal line). 

TS organizes these segments into five geographic zones, as listed in Table C2. There is an 
overlap between zones (not reflected in Table C2) such that two rows of segments from each zone 
extend into the adjacent zone. This minimizes display "jumping" if a pilot is flying along a 
zone boundary. The amount of overlap in degrees of latitude is scale dependent (since the size of 
a segment depends on the scale). For more information about the TS projection system, refer to 
Lohrenz et al. (1993). 

Table Cl — DTED Longitudinal Post 
Spacing (Level 1 vs. Level 2) 

ZONE LAT BOUNDS 

POST SPACING 
(ARC S) 

LEVEL 1 LEVEL 2 

I 0°-50° N/S 3 1 

II 50°-70° N/S 6 2 

III 70°-75° N/S 9 3 
IV 75°-80° N/S 12 4 

V 80°-90° N/S 18 6 
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Table C2 — TS Geographie Zones 

ZONE 
ID 

ZONE 
NAME 

N LATITUDE 
BOUND 

S LATITUDE 
BOUND 

0 
1 

2 
3 

4 

North Polar 
North Temperate 

Equatorial 
South Temperate 

South Polar 

90.00° N 
51.69° N 

31.38° N 

31.38° S 
51.69° S 

51.69° N 

31.38° N 
31.38° S 
51.69° S 

90.00° S 

C2.6 World Vector Shoreline (WVS) 

WVS is the base map for defining coverages for AOD images and MPS-CD images on the 
MAP-II workstation. WVS is a standard NIMA digital product consisting of the shorelines, inter- 
national boundaries, and country names of the world. The uncompressed version of WVS averages 
12 data points per nautical mile (nmi), approximately equivalent to the data density of a scanned 
1:250,000 scale chart. WVS conforms to the WGS 84 datum. Compressed and thinned versions of 
WVS are also available from NIMA. For more details, refer to NIMA's Digitizing the Future 
(NIMA 1997). 

C3.0 CHART SERIES, SCALES, AND DISPLAY RANGES 

Chart series and geographic scale typically refer to paper chart products: a Joint Operations 
Graphic (JOG) chart series is produced at a scale of 1:250,000, which means that 1" on the chart 
represents 250,000" on the ground. For aeronautical charts, larger scales (e.g., 1:50,000 and 1:100,000) 
provide more detailed chart information for low-altitude flying or approach and landing operations. 
Smaller scales (e.g., 1:2,000,000 and 1:5,000,000) are used for faster flying at high altitudes (e.g., 
cross-country flights). 

The term "chart scale" is not always appropriate for digital chart products, since the actual 
scale may become distorted by zooming or subsampling the data. For digital charts, it may be more 
useful to refer to display range, e.g., the number of nautical miles from the top to the bottom of 
the screen on which the digital chart is displayed. 

Table C3 is a list of the common aeronautical chart series, along with their paper chart scales 
and normal (pre-zoom) display ranges. The table also indicates, for each chart series, if it is 
supported by current moving map displays and if it will be supported under the new TAMMAC 
systems. 

C4.0 AGENCffiS AND COMPANIES 
C4.1 Defense Mapping Agency (DMA) 

DMA has been reorganized and renamed to the National Imagery and Mapping Agency (NIMA). 
See following description. 
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Table C3 — Common Aeronautical Chart Series, Scales, and Display Ranges 

CHART SERIES SCALE*1 

DISPLAY 
RANGE (nmi)*2 

AV-8B    F/A-18 

IN 
CURRENT 
SYSTEM? 

IN 
TAMMAC 
SYSTEM? 

Global Navigation Chart (GNC) 1:5M 200 160 No Yes 

Jet Navigation Chart (JNC) 1:2M 100 80 Yes Yes 

Operational Navigation Chart (ONC) 1:1M 50 40 *3 Yes 

Tactical Pilotage Chart (TPC) 1:500k 25 20 Yes Yes 

Joint Operational Graphics (JOG) 1:250k 13 10 Yes Yes 

Topographic Line Map-100 (TLM-100) 1:100k 5 4 Yes Yes 

Topographic Line Map-50 (TLM-50) 1:50k 3 2 No Yes 

#1 For chart scales, M = million, k = thousand. 

*2 AV-8B and F/A-18 use the same display but calculate range differently (Trenchard et al. 1995). 

*3 The ONC series is not supported in current systems; instead, pilots 
chart by 2:1 to simulate an ONC display range. 

can zoom in to the JNC 

C4.2 Honeywell 

As subcontractor to McDonnell Douglas, Honeywell manufactured and distributed most of the 
hardware components for the AV-8B and F/A-18 cockpit moving map systems, including the DMU 
used by both the Map Station and the cockpit map computer. Honeywell also developed the TS 
projection system and CAC data base format, specifications, and original compression software, 
which were later transitioned to NRL. NRL made significant modifications to the CAC compression 
software before transitioning it to NIMA in September 1995. 

C4.3 Horizons Technology, Inc. (HTI) 

HTI is the original manufacturer and distributor of the MOMS system. HTI is located in 
San Diego, CA. 

C4.4 Naval Air Weapons Center (NAWC) 

NAWC Weapons Division, China Lake, CA, retrofitted the MOMS software with Pentium PC 
platforms to develop the Mission Planning System-II (MPS-II) and Maintenance Data System-II 
(MDS-II) for the AV-8B Muxbus Data System. NAWC tasked NRL to develop the MAP-II workstation 
for AV-8B. The following are key NAWC personnel in this effort: 

Project Team Leader: Diana Lemon 

Project Engineers: Luie Trudy, Jean Carlton 
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C4.5 National Imagery and Mapping Agency (NIMA) 

NIMA—formerly the Defense Mapping Agency (DMA)—produces and distributes the standard 
cartographic data bases that support the cockpit moving map, MAP-II, MPS-II, and MDS-II 
systems, including CAC, DTED, and WVS. 

C4.6 Naval Research Laboratory (NRL) 

The NRL Mapping Sciences Section (Code 7441) developed the MAP-II workstation and Moving 
Map Composers (MMC) software for the AV-8B Muxbus Data System. NRL Code 7441 is located 
at Stennis Space Center, MS, which is on the Gulf of Mexico approximately 70 miles northeast of 
New Orleans, LA. The following are key NRL personnel in this effort: 

• Project Team Leader: Maura Lohrenz 

• Project Engineers: Marlin Gendron, Michelle Mehaffey, Stephanie Myrick, Mike Trenchard, 
and Perry Wischow 


